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What is the Rhode Island Code of Regulations? 
 

The Rhode Island Code of Regulations (RICR) is the official 
publication of the rules promulgated by State agencies, 
boards, and commissions. The RICR is a uniform code that 
provides access to all Proposed and Final Regulations filed 
under the Administrative Procedures Act. 
 

The Department of State’s Administrative Records Office 
(ARO) manages the RICR, which is updated daily and 
available to the public online.  

 
What is the Administrative Records Office? 
 

The ARO manages the process of regulations filed by State 
agencies with the Department of State to make 
government more transparent, accessible, and efficient. 

 
What is the Administrative Procedures Act? 
 

R.I. Gen. Laws Chapter 42-35, Administrative Procedures 
Act, governs the way Rhode Island State agencies, boards, 
and commissions may propose and promulgate rules. 

 
What are an agency’s responsibilities? 
 

All agency responsibilities regarding rules and regulations 
can be found in the Administrative Procedures Act (R.I. 
Gen. Laws Chapter 42-35). 

 
What do the OMB and the ARO review? 
  

The Office of Management and Budget (OMB) facilitates 
the creation and refinement of regulations through a 
content review process to ensure a clear, predictable, and 
reliable regulatory system (EO 15-07). 
 
The ARO facilitates a formatting review process for 
standardization and display in the RICR (R.I. Gen. Laws § 
42-35-4(a)). 

 
What is “Content”? 
 

“Content” means any text or graphics of the rulemaking 
records that impacts the meaning and/or intent. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
https://omb.ri.gov/regulatory-reform
https://omb.ri.gov/sites/g/files/xkgbur751/files/documents/reform/regulatory-review/07_Regulatory_Climate.pdf
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
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1.1 History of Rhode Island Regulations 

Date Event 

1956 

Administrative Procedures Act (APA) Adopted 

For rules previously in effect, and going forward for Final Regulations, to be filed 

with the Department of State (DOS) and enacted on 01/01/1964. 

2000 

Rhode Island Small Business Regulatory Flexibility Act Adopted 

Small business regulatory review board established to consider requests from 

small business owners to review rules adopted by state agencies. 

2001 

Launch of 1st Online Regulation Database 

While paper regulations are still the official copy, the online database makes 

regulations available for public accessibility and reference only. 

2004 

APA Amended 

Regulations are now to be reviewed by the Governor’s Office and Economic 

Development Corporation (EDC) for small business impact before filing. 

2010 
Office of Regulatory Reform (ORR) Established (Executive Order 10-13) 

ORR established within the EDC to improve regulatory process. 

2012 ORR Moved to the Office of Management and Budget (OMB) 

2015 

ORR Review (Executive Order 15-07) 

Requires most Executive departments, boards, and commissions with 

rulemaking authority to have rules reviewed by ORR before and after public 

comment. 

2016 
APA Amended 

Rewritten, based on Uniform APA, to revise the rulemaking process. 

August 

2018 

Launch of Rhode Island Code of Regulations (RICR) 

Administrative Records Office (ARO) reviews rules for formatting compliance, 

maintains final rulemaking record copies and official copies of regulations, and 

maintains the online system to file and display regulations for public accessibility. 
 

Prior to this time, only agencies were responsible for maintaining all rulemaking 

records. Now, both the agency and the ARO maintain all rulemaking records. 

2020 

Emergency Rules Extended (Executive Order 20-72) 

Temporarily suspended a section of the APA allowing only one 60-day extension 

to allow for multiple extensions, if need be, due to the COVID-19 emergency. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
https://statelibrarycatalog.sos.ri.gov/cgi-bin/koha/opac-detail.pl?biblionumber=34615
https://omb.ri.gov/sites/g/files/xkgbur751/files/documents/reform/regulatory-review/07_Regulatory_Climate.pdf
https://www.uniformlaws.org/committees/community-home?CommunityKey=f184fb0c-5e31-4c6d-8228-7f2b0112fa42
https://governor.ri.gov/executive-orders/executive-order-20-72
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1.2 Administrative Records Definitions 

For the purpose of this Guide, the following terms are defined as follows: 
 
“Advance” means the step in the filing process in the RICR Filing System to move the 
rule one step forward. 
 
“Advance Notice of Proposed Rulemaking” means the process of when an agency 
may collect relevant information to a potential rule and may solicit comments and 
recommendations from the public (R.I. Gen. Laws § 42-35-2.5 and § 3.3.4 of this 
Guide). 
 
“Agency Head” means the individual who has ultimate legal authority of an agency 
(R.I. Gen. Laws § 42-35-1(3)), is an RICR Filing System user, and may sign rules into 
effect (§ 6.1.1 of this Guide). 
 
“Agency” means “a state agency, authority, board, bureau, commission, department, 
district, division, institution, office, officer, quasi-public agency, or other political 
subdivisions created by the general assembly or the governor, other than the 
legislature or the judiciary, that is authorized by law of this state to make rules” (R.I. 
Gen. Laws § 42-35-1(1)). 
 
“Declaratory Order” means a document issued by an agency that states whether a 
statute or regulation applies to the person or entity petitioning the agency for that 
decision. (R.I. Gen. Laws § 42-35-8). 
 
“Effective Date” means the exact date a promulgation goes into effect. 
 
“Filer” means a person approved by an agency to participate in the rulemaking 
process to file regulations for that agency and is an RICR Filing System user (§ 6.1.3 of 
this Guide). 
 
“Filing Date” means the exact date a promulgation is filed with the Department of 
State. 
 
“Guidance Document” means “a record of general applicability developed by an 
agency which lacks the force of law but states the agency’s current approach to, or 
interpretation of, law or describes how and when the agency will exercise 
discretionary functions” (R.I. Gen. Laws § 42-35-1(9)). 
 
“Notice of Proposed Rulemaking” means a document published in the RICR for 
notification to interested parties of a Proposed Rule. The notice must contain the 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.5.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-8.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
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items described in R.I. Gen. Laws 42-35-2.7. 
 
“Promulgate” means “the process of writing a new rule, or amending or repealing an 
existing rule”, beginning “with filing the Notice of Proposed Rulemaking…and ending 
upon the Effective Date of the rule” (R.I. Gen. Laws § 42-35-1(16)). 
 
“Promulgation,” with respect to a rule filed in the RICR Filing System, means the 
specific Adoption, Amendment, or Repeal that is being promulgated. 
 

“Promulgation ID” means the distinctive identification number a promulgation 
is assigned by the RICR Filing System that is used by the Department of State 
to identify rules. 

 
“Public Comment Period” means a period of time after the Notice of Proposed 
Rulemaking is published in the RICR during which a person may submit comments on 
the Proposed Rule. 
 
“Public Hearing” or “Hearing” means a meeting regarding a proposed rule which is 
open to the public, during which members of the public are invited to give testimony 
or otherwise submit comments on the Proposed Rule. The hearing is recorded and 
kept as part of the Rulemaking Record for that rule. A hearing may not be scheduled 
earlier than ten (10) days after the Notice of Proposing Rulemaking is published in the 
RICR or later than five (5) days prior to the end of the Public Comment Period. 
 
“Rhode Island Code of Regulations” or “RICR” (pronounced are-aye-see-ARE) means 
the official publication of Rhode Island Regulations promulgated by agencies that is 
managed by the Department of State’s Administrative Records Office, which is 
updated daily and available to the public on the Department of State’s website. 
 
“RICR citation” means the unique number assigned to a rule that includes the Title, 
Chapter, Subchapter, and Part numbers (§ 2.3 of this Guide) that is used by agencies 
and the public to identify rules. 
 
“RICR Filing System” or “RICR System” means the online filing system that allows 
agencies to file regulations directly with the Department of State. 
 
“Rule” or “Regulation” means “the whole or a part of an agency statement of general 
applicability that implements, interprets, or prescribes law or policy or the 
organization, procedure, or practice requirements of an agency and has the force of 
law” (R.I. Gen. Laws § 42-35-1(19)). “Regulation” has the same meaning and is used 
interchangeably. Rules may be described by the status in which they are in, including 
the following: 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
https://rules.sos.ri.gov/Organizations
https://rules.sos.ri.gov/
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
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“Active Rule” means a rule that was promulgated in accordance with the APA 
and is currently in effect and enforceable by the agency. 
 
“Final Rule” means a rule that was promulgated in accordance with the APA 
and currently is, or was at one time, in effect and enforceable by the agency. 
 
“Inactive Rule” means a rule that was previously promulgated in accordance 
with the APA and in effect that is no longer in effect and enforceable by the 
agency. 
 
“Proposed Rule” means a rule that is in the promulgation process that has not 
yet gone into effect to become a Final Rule. 
 
“Terminated Rule” means a Proposed Rule that was in the promulgation 
process but was discontinued by the agency before going into effect. 
 

“Rules Coordinator” means the designated individual at an agency who has 
knowledge of all Proposed Rules, maintains rulemaking records for the agency as 
required in R.I. Gen. Laws § 42-35-2.3, responds to public inquiries regarding all 
agency rules (R.I. Gen. Laws § 42-35-2.1), and is an RICR Filing System user (§ 6.1 of 
this Guide). 
 
“Rulemaking” means the promulgation process based on the action and type: 
 

“Rulemaking Action” means the kind of rulemaking, either Proposed Regular, 
Proposed Direct Final, Emergency, Advance Notice, or APA Exempted (§ 3.2 of 
this Guide). 

 
“Rulemaking Type” means the category of rulemaking, either an Adoption, 
Amendment, Repeal, Technical Revision, or Periodic Refile (§ 3.1 of this 
Guide). 

 
“Rulemaking Agenda” means the record an agency must maintain for proposed 
rules, which is also available in the RICR for each agency (§ 2.6.3 of this Guide), that 
states or contains the items described in R.I. Gen. Laws § 42-35-5.1. 
 
“Rulemaking Record” means the group of records agencies are required to maintain 
for each rule, which must contain the records described in R.I. Gen. Laws § 42-35-2.3. 
 
“Terminate” or “Termination” means the irreversible process of ending a rule in the 
middle of the promulgation process before an Effective Date is set, which stops the 
Proposed Rule from displaying in the RICR (if it had already gone into the Public 
Comment Period), removes the rule from the RICR user’s Work Queue, and if the rule 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-5.1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
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was an Adoption it prevents that Part number from being used again. 
 
“User” means a person with login credentials to the RICR Filing System, either a Filer, 
Rules Coordinator, or Agency Head. 
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2.1 About the RICR 

The Rhode Island Code of Regulations (RICR) is the official publication of rules 
promulgated by State agencies, boards, and commissions. The Department of State’s 
Administrative Records Office (ARO) manages the RICR, which is updated daily and 
available online at https://rules.sos.ri.gov/organizations. 
 
Each rule published in the RICR is given a unique citation (XXX-RICR-XX-XX-X) which 
includes numbers for the Title, Chapter, Subchapter, and Part: 
 

100-RICR-40-15-1 

 
Title (Agency)   Chapter (Function)   Subchapter (Topic)   Part (Regulation) 

 

To view the additional information regarding the rulemaking process, definitions for 
the RICR, and FAQs, visit: https://rules.sos.ri.gov/organizations/help. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/organizations
https://rules.sos.ri.gov/Organizations/help
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2.2 The Rulemaking Process 

2.2.1 Beginnings of a Rule 

An agency may only publish a rule for which it has statutory authority. Each Notice of 
Proposed Rulemaking must include the legal citation that authorizes the rule. 
 
An agency may choose to employ an optional step in the rulemaking process for an 
Advanced Notice of Proposed Rulemaking (R.I. Gen. Laws § 42-35-2.5). This allows an 
agency to gather information related to the potential Rulemaking Action by soliciting 
comments and recommendations from the public before publishing the Proposed 
Rule and Notice of Proposed Rulemaking. 
 
Executive Order 15-07 requires most executive branch agencies to engage in the 
Office of Management and Budget’s review process prior to filing regulations. 
 
 

2.2.2 Preliminary Evaluations and Analysis 

Before the rulemaking process begins, an agency must evaluate all alternative 
approaches, overlap or duplication with other statutes and rules and whether the 
Rule will have significant economic impact on small business. 
 
 

2.2.3 Notice of Proposed Rulemaking 

After an agency researches the issues and determines whether a new rule is 
necessary, it often proposes the new language along with a Notice of Proposed 
Rulemaking. These notices are published in the RICR, are readily available to the 
public, and contains details about the Proposed Rule including the Rule’s purpose, its 
statutory authority, and how the public can submit a comment or get further 
information about the Proposed Rule from the agency, available in the Rulemaking 
Documents tab of the RICR website (§ 2.5.5 of this Guide). 
 
 

2.2.4 Public Comment Period 

For most rulemaking actions, agencies must accept comments from the public about 
the Proposed Rule. Agencies may choose to do so directly through the RICR, or by 
mail, fax, or email. If a Public Hearing is scheduled, the public can also submit 
comments via testimony at a Public Hearing. For most Rulemaking Actions, an agency 
must allow a minimum of thirty (30) days for public comment. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.5.htm
https://governor.ri.gov/executive-orders/executive-order-15-07
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2.2.5 Public Hearing 

An agency may schedule one (1) or more Public Hearings on the Proposed Rule. The 
date, time, and location of any scheduled hearing must be listed in the Notice of 
Proposed Rulemaking. The Public Hearing must be scheduled at least ten (10) days 
from the date the Notice is published and at least five (5) days before the Public 
Comment Period ends. An agency must also schedule a Public Hearing if the hearing 
is requested by twenty-five (25) people or by an organization with at least twenty-five 
(25) members (R.I. Gen. Laws § 42-35-2.8). 
 
 

2.2.6 End of Public Comment Period 

Once the Public Comment Period ends, the agency must review all comments 
received and evaluate whether to make logical changes to the rule based on those 
comments. The agency must also prepare a Concise Explanatory Statement including 
its reasons for not incorporating changes suggested by the public, if necessary, and a 
description of any changes made between the text of the Proposed Rule and the 
Final Rule to be filed with the DOS. 
 
 

2.2.7 Final Rule Filing 

The Final Rule must be filed no later than one hundred eighty (180) days after the end 
of the Public Comment Period in the RICR Filing System or the rule will be 
automatically terminated by the RICR System at that time (R.I. Gen. Laws § 42-35-4(c)). 
The Final Rule and its associated documents in the Rulemaking Record must be filed 
with the DOS for publication in the RICR to become effective (R.I. Gen. Laws § 42-35-
2.3). 
 
 

2.2.8 Emergency Rulemaking 

According to R.I. Gen. Laws § 42-35-2.10, “if an agency finds that an imminent peril to 
the public health, safety, or welfare or the loss of federal funding for an agency 
program requires the immediate promulgation of an emergency rule...” the agency 
may proceed with the Rulemaking Action without a Public Comment Period or Public 
Hearing. Emergency Rules come into effect once they are signed by the Agency Head 
and the Governor or the Governor’s designee. These rules are effective for up to one 
hundred twenty (120) days and may be extended once for an additional sixty (60) 
days. 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.8.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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2.3 RICR Classification System 

The Rhode Island Code of Regulations (RICR) is a classification system that orders 
regulations by agency. Each agency is organized by its Title, then further organized 
into Chapters, Subchapters, and Parts, with each Part organized by Sections. All 
number representations for Titles, Chapters, Subchapters, or Parts must be whole 
numbers (decimal points are not permitted). 
 
All rules are assigned an RICR citation using the Title, Chapter, Subchapter, and Part 
numbers. Sections may be cited after the Part number. For additional information, 
see § 5.2.1.3 of this Guide. 
 
 

2.3.1 Title 

A Title is the entity name, represented by a three-digit number for agencies with 
specific rulemaking authority granted by R.I. Gen. Laws. 
 
The numbering scheme begins with 100 and increases by multiples of 2, 5, or 10, 
based on the entity type and its relationship to other entities in the RICR. The three-
digit indicator allows for growth over time, including the placement of new agencies 
near related agencies (e.g., Title 210 has sub-agencies represented by 212, 214, etc.). 
 

100-RICR-40-15-1 
 
 
 

2.3.2 Chapter 

A Chapter is a core function of the agency, which is represented by a two- or three-
digit number.  
 
Agencies can distinguish between functions by assigning a Chapter number using a 
skip ten (10) method (e.g., 10, 20, 30…, 110, etc.). This skip method allows room to 
insert new functions near related functions in the future. Agencies may use “00” and 
“N/A” as the Chapter name if there is no need to differentiate a topic. 
 

100-RICR-40-15-1 
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2.3.3 Subchapter 

A Subchapter is a topic area within the core function of the agency, which is 
represented by a two- or three-digit number. 
 
Agencies can distinguish between topics by assigning a Subchapter number using a 
skip five (5) method (e.g., 05, 10, 15, etc.). Agencies may use “00” and “N/A” as the 
Subchapter name if there is no need to differentiate a topic. 
 

100-RICR-40-15-1 
 
 
 

2.3.4 Part 

A Part is the individual rule regulating a specific topic, which is represented by a one-, 
two-, or three-digit number. 
 
Agencies can distinguish between specific topics by assigning a Part number using a 
skip one (1) method without a leading zero (e.g., 1, 2, 3, etc., not 01, 02, 03, etc.). 
 
Parts cannot be renumbered to accommodate repealed Rules, nor can Part numbers 
be reused if terminated before becoming effective. Once a Part number is used, it is 
in the RICR Filing System database and part of the permanent rulemaking records. 
 

100-RICR-40-15-1 
 
 
 

2.3.5 Section 

Sections are the individual headings that make up a Part (rule), divided into six (6) 
levels, including four (4) paragraph levels: 
 

1. RICR Heading 1 (ex., #.1, #.2, #.3, etc.) 
 

2. RICR Subheading/Subchapter (ex., #.#.1, #.#.2, #.#.3, etc.) 
 

3. RICR Paragraph 1 (ex., A., B., C., etc.) 
 

4. RICR Paragraph 2 (ex., 1., 2., 3., etc.) 
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5. RICR Paragraph 3 (ex., a., b., c., etc.) 
 

6. RICR Paragraph 4 (ex., (1), (2), (3), etc.) 
 
Agencies should make every attempt to limit the number of section levels to no more 
than four (4) paragraph levels to reduce regulatory volume while maintaining 
readability. In the rare case where additional levels are required, there are two (2) 
additional paragraph levels available: 
 

7. RICR Paragraph 5 (ex., (A), (B), (C), etc.) 
 

8. RICR Paragraph 6 (ex., (i), (ii), (iii), etc.) 
 

 

100-RICR-40-15-1.2(B)(3)(e)(2)(A)(ii) 
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2.4 Locating Regulations 

For regulations filed since 2001, there are two (2) ways to find them in the RICR: 
 

1. Browse an agency’s rules by exploring the Parts listed within their Title’s 
Chapters and Subchapters in the RICR Table of Contents; or 
 

2. Use the search feature to search a specific keyword or RICR citation. 
 
 

2.4.1 RICR Table of Contents (2001-Current) 

To browse a specific agency’s rules: 
 

1. Go to: https://rules.sos.ri.gov/Organizations. 
 

2. Locate the Title of the agency of interest either by scrolling through the agency 
or using the Filter by Agency search box: 
 

 
 

3. Click the plus (+) button to toggle open the agency’s Title to view the Chapters 
(click the minus (-) button to toggle the Title closed again): 
 

 

https://rules.sos.ri.gov/Organizations
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4. Continue to toggle open the associated Chapter and Subchapter, and click on 
the Part to view the Regulation: 
 

 
 
 

2.4.2 RICR Search (2001-Current) 

There are multiple ways to find RICR rules using the search feature. To search, go to 
https://rules.sos.ri.gov/Organizations and navigate to the Search Regulations box: 

 

 

https://rules.sos.ri.gov/Organizations
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1. If you know the unique RICR citation for the rule: 
Type the full citation (with “RICR” in all capital letters) and click Search to view 
the currently active version of that Part. 
 

2. If you do not know the RICR citation, but know the name of the rule: 
Type in keywords and click Search to view a list of related regulations. 
 

3. To view all rules for a specific agency: 
Select the agency from the dropdown, type in keywords if known and/or click 
Search to view all related regulations with that specific agency. 
 

4. To view all RICR rules: 
Do not type any text or select an agency, just click Search with empty fields. 
 

When viewing the Search Results, to further narrow down the list of regulations, click 
to sort between Active (all Rulemaking Actions and Types, § 3 of this Guide), 
Emergency, Proposed, and Inactive: 
 

 
 

NOTE:  The search function will not recognize two different keywords at once 
(i.e., “fishing and hunting” will not search simultaneously for results 
containing both of those terms). 
 
Additionally, the search will scan the entire text of all rules and weight the 
results first by rules that contain the keyword in the Part name, then by 
rules which contain the keyword in the full text of the Part. 
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2.4.3 Historic Regulations (1950-2001) 

Since 2001, regulations have been filed electronically and are available in the RICR. 
To view rules filed with the Department of State in early 2001 and prior: 
 

1. Go to the Rhode Island State Archives Catalog. 
 

2. Select an entity from the Collection Organization sidebar: 
 

 
 

3. Click Go to file to open a list of historic rules for that entity in the Digital 
Archive: 
 

 

https://catalog.sos.ri.gov/repositories/2/resources/340
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2.5 Viewing Regulation Information (2001-Current) 

2.5.1 Regulation Text 

Click the Regulation Text tab to view the rule interactively. Click the Section 
number/name to open and click that Section number/name again to close: 
 

 
 
 

2.5.2 Overview 

To view additional information, including the type of filing, status, effective dates, 
regulation authority, and purpose and reason for this filing, click the Overview tab: 
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2.5.3 Regulation 

To download the rule as a PDF, click the Regulation tab > Download Regulation: 
 

 
 
 

2.5.4 History 

To view a rule’s history, click the History tab to navigate to any previous filing for that 
Part (the filing highlighted blue is the rule that is currently being viewed): 
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2.5.5 Rulemaking Documents 

To view all associated documents for the filing (i.e., Concise Explanatory Statement, 
Public Comment, Notice of Proposed Rulemaking, Proposed Rule, etc.), click the 
Rulemaking Documents tab: 
 

 
 

NOTE: Only Rulemaking Documents from rules filed since 2018 are available. 
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2.6 Locating Agency Information 

To view agency information for a specific Title: 
 

1. Go to https://rules.sos.ri.gov/Organizations. 
 

2. Locate the Title in the Table of Contents or use the Filter by Agency search 
box: 

 

 
 

3. Click the plus (+) button next to the Title, then click View Agency Info: 
 

 
 

4. The Agency Info page includes a description, the agency’s address, and the 
Rules Coordinator’s contact information (see § 2.6.4 of this Guide to update): 
 

 

https://rules.sos.ri.gov/Organizations
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2.6.1 Guidance Document Index 

To view an agency’s Guidance Document Index that lists published Guidance 
Documents, navigate to the bottom of the Agency Info page and click Guidance 
Document Index: 
 

 
 
 

2.6.2 Declaratory Order Index 

To view an agency’s Declaratory Order Index that lists published Declaratory Orders, 
navigate to the bottom of the Agency Info page and click Declaratory Order Index: 
 

 
 
 

2.6.3 Rulemaking Agenda 

To view an agency’s Rulemaking Agenda that provides that agency’s Proposed Rules, 
navigate to the bottom of the Agency Info page and click Rulemaking Agenda: 
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2.6.4 Updating Agency Information 

2.6.4.1 About Description 

The Rules Coordinator or Agency Head may email the Administrative Records 
Office (ARO) the Title number and updated agency description and the ARO can 
update the RICR on the agency’s behalf: 
 

 
 
 

2.6.4.2 Agency Address 

The Rules Coordinator or Agency Head may email the ARO the Title number and 
updated agency address and the ARO can update the RICR on the agency’s 
behalf: 
 

 
 
 

2.6.4.3 Rules Coordinator 

To update the Rules Coordinator, see § 6.1.2.1 of this Guide. 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov


 
 
 
 

 38 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

2.7 Subscribing to Regulation Notifications 

There are multiple ways to subscribe to email notifications to be alerted of RICR 
rulemaking activity: 
 

1. To subscribe to all notifications or notifications for a specific agency: 
Click Subscribe for Notifications located below the search box and complete 
the form to receive daily, weekly, or monthly email notifications for all agencies 
or specific agencies: 
 

 
 

2. To receive notifications for a specific Chapter, Subchapter, or Part: 
Click Notify Me within the Overview tab of any Part and complete the form to 
receive daily, weekly, or monthly email notifications for the Agency, the 
Chapter, the Subchapter, or the Part: 

 

 
 

3. To unsubscribe to RICR Notifications: 
 

a. Either: 
 

i. Navigate to the bottom of the RICR Notification email and click 
the link to visit and unsubscribe: 
 

 
 
OR 
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ii. Go to https://rules.sos.ri.gov/Organizations and click Subscribe 
for Notifications: 
 

 
 

b. Enter the email address and click Manage Subscriptions: 
 

 
 

c. Select the checkbox for the subscriptions(s) and click Unsubscribe: 
 

 
 

https://rules.sos.ri.gov/Organizations
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3 RULEMAKING TYPES & ACTIO NS  
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3.1 Rulemaking Types 

There are five (5) Rulemaking Types: 
 

1. Adoption 
To create a new rule. 
 

2. Amendment 
To alter, modify, rephrase, add to, or subtract from an Active Regulation. 
 

3. Repeal 
To revoke an Active Regulation, abolishing the ability for the rule to be 
enforced. 
 

4. Technical Revision* 
For minor non-substantive corrections to rules. 
 

5. Periodic Refile* 
To refile all rules on file with the Department of State every successive fifth 
year. 

 

*For additional information, see §§ 3.3.6 and 3.3.7 of this Guide. 
 
 

3.2 Rulemaking Actions 

For Adoptions, Amendments, and Repeals, there are five (5) Rulemaking Actions: 
 

1. Proposed Regular 
Most common type. 
 

2. Proposed Direct Final 
For non-controversial rules. 
 

3. Emergency 
To address imminent peril. 
 

4. Advance Notice 
To gather additional information before promulgating a rule. 
 

5. APA Exempted 
For exempted entities only. 

 

For exact processes and document requirements, refer to the Rulemaking Workflows. 

https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
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3.3 Rulemaking Timelines 

Proposed Adoptions, Amendments, and Repeals, of any Rulemaking Action, must be: 
 

1. Reviewed with content approved by the Office of Management and Budget 
(OMB)*; 
 

2. Reviewed with formatting verified by the Department of State (DOS); and 
 

3. Signed by the DOS to be published in the RICR. 
 

*General Officer rules, Judiciary rules, and APA Exempted Rulemaking excluded. 
 
Click here to view a visual timeline for each Rulemaking Action, for example: 
 

 
 
 

3.3.1 Proposed Regular Rulemaking 

This is the most common type of rulemaking. This Rulemaking Action includes: 
 

1. OMB Initial Review (up to 30 days); 
 

2. DOS Drafts Verification (up to 5 days); 
 

3. Public Comment Period (30-day minimum); 
 

4. OMB Final Review (up to 30 days); and 
 

5. DOS Final Review (up to 5 days). 
 
The Final Rule becomes effective after the 20-day minimum waiting period, starting 
from when the DOS signs the Regulation, after the above process and the Agency 
Head signs the rule. 
 
 

3.3.2 Proposed Direct Final Rulemaking 

This is only to be used when the rule is expected to be non-controversial. If the rule 
receives any objections in the Public Comment Period, the rulemaking process must 
restart from the beginning using Proposed Regular Rulemaking (R.I. Gen. Laws § 42-
35-2.11). 

https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.11.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.11.htm
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This Rulemaking Action includes: 
 

1. OMB Initial Review (up to 30 days); 
 

2. DOS Drafts Verification (up to 5 days); 
 

3. Public Comment Period (30-day minimum); 
 

4. DOS Final Review (up to 5 days). 
 
The Final Rule becomes effective at the end of the Public Comment Period if no 
objections were received (and the agency does not request a future Effective Date) 
once the DOS signs the Regulation, after the above process and the Agency Head 
signs the rule. 
 
 

3.3.3 Emergency Rulemaking 

This is only to be used if an agency finds that there is an imminent peril to public 
health, safety, or welfare or the loss of federal funding for an agency program and 
requires an immediate promulgation (R.I. Gen. Laws § 42-35-2.10). 
 
An Emergency Rule may be effective for one hundred twenty (120) days, renewable 
once for sixty (60) days. 
 
This Rulemaking Action includes: 
 

1. OMB Initial Review (up to 30 days); 
 

2. OMB Extension Review (up to 30 days, optional). 
 
The Final Rule becomes effective as soon as the Agency Head and Governor’s Office 
signs the Regulation, after the above process. 
 
 

3.3.4 Advance Notice of Proposed Rulemaking 

This is an optional process if an agency chooses to gather information and solicit 
comments from the public before promulgating (R.I. Gen. Laws § 42-35-2.5). 
 
If an agency chooses to hold a Public Hearing regarding an Advance Notice of 
Proposed Rulemaking, the hearing must be posted to the Open Meetings database 
in accordance with the Open Meetings Act (R.I. Gen. Laws Chapter 42-46). 
This Rulemaking Action includes: 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.5.htm
https://opengov.sos.ri.gov/OpenMeetings
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-46/INDEX.HTM
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1. Public Comment Period (1-day minimum); 
 

2. OMB Initial Review (up to 30 days); 
 

3. DOS Drafts Verification (up to 5 days); 
 

4. Public Comment Period (30-day minimum); 
 

5. OMB Final Review (up to 30 days); and 
 

6. DOS Final Review (up to 5 days). 
 
This Rulemaking Action follows the same process as Proposed Regular Rulemaking 
after the initial advanced Public Comment Period, and the Final Rule becomes 
effective after the 20-day minimum waiting period, starting from when the DOS signs 
the Regulation, after the above process and the Agency Head signs the rule. 
 
 

3.3.5 APA Exempted Rulemaking 

None of the provisions of R.I. Gen. Laws Chapter 42-35 shall apply to the agencies 
listed in R.I. Gen. Laws § 42-35-18(b), as they are exempt (R.I. Gen. Laws § 42-35-18). 
 
If agencies listed use the RICR to file rules, this Rulemaking Action includes: 
 

1. DOS Review (up to 5 days). 
 
This Rulemaking Action does not require an OMB content review, includes no Public 
Comment period, and the Final Rule becomes effective either immediately or after an 
optional waiting period, as requested by the agency, after the above process and the 
Agency Head and DOS signs the rule. 
 
 

3.3.6 Technical Revision 

Minor non-substantive corrections, including typographical, grammatical, or 
formatting errors, may be made to final rules (R.I. Gen. Laws § 42-35-4(b)). 
 
This Rulemaking Action includes: 
 

1. DOS Review (up to 5 days). 
 
This Rulemaking Action does not require an OMB content review, includes no Public 
Comment Period and no waiting period, and the Final Rule’s Effective Date will be set 
to the same Effective Date of the original filing that required the Technical Revision, 
after the above process. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
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3.3.7 Periodic Refile 

All rules that are on file with the DOS must be refiled on the first Tuesday in January 
of every successive fifth year, starting January 2007 (R.I. Gen. Laws § 42-35-4.2). 
 
This Rulemaking Action includes: 
 

1. DOS Review. 
 
This Rulemaking Action does not require an OMB content review or DOS formatting 
review, includes no Public Comment Period and no waiting period, and the Final 
Rule’s Effective Date will be set to the first Tuesday in January of every successive fifth 
year. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.2.htm
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4 WRITING RE GULATIO NS 
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4.1 Regulation Drafting Guidance 

For resources and guidance on regulatory drafting and other required content 
components, refer to the Office of Management and Budget’s online resources. 
 
Questions about the OMB content review process can be directed to the agency’s 
assigned analyst or contact OMB directly at omb.regsubmission@omb.ri.gov. 
 
 

4.2 APA Requirements 

4.2.1 Petition for Promulgation of Rules 

Each agency must promulgate a rule providing an explanation of the procedure for 
an individual to petition the agency to promulgate a rule (R.I. Gen. Laws § 42-35-6). 
The Rule must contain the following: 
 

1. The form of the petition; and 
 

2. The procedure for its submission, consideration, and disposition. 
 
The Department of State has provided a sample Petition for Promulgation of Rules 
Regulation, intended as a tool for agencies’ use in promulgating their own rule as 
required in R.I. Gen. Laws § 42-35-6. Agencies are not required to use the sample 
when promulgating their rule. 
 
 

4.2.2 Petition for Declaratory Order 

Each agency must promulgate a rule providing an explanation of the procedure for 
an individual to petition the agency to publish a Declaratory Order (R.I. Gen. Laws § 
42-35-8). The Rule must contain the following: 
 

1. The form of the petition; and 
 

2. The procedure for its submission, consideration, and disposition. 
 
The Department of State has provided a sample Petition for Declaratory Order 
Regulation, intended as a tool for agencies’ use in promulgating their own rule as 
required in R.I. Gen. Laws § 42-35-8. Agencies are not required to use the sample 
when promulgating their rule. 
 
 

https://omb.ri.gov/regulatory-reform/regulatory-review
mailto:omb.regsubmission@omb.ri.gov
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-6.htm
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-6.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-8.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-8.htm
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-8.htm
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4.2.3 Conduct of Public Hearings 

Each agency must promulgate a rule providing the way public hearings are 
conducted (R.I. Gen. Laws § 42-35-2).  
 
The Department of State has provided a sample Conduct of Public Hearings 
Regulation, intended as a tool for agencies’ use in promulgating their own rule as 
required in R.I. Gen. Laws § 42-35-2. Agencies are not required to use the sample 
when promulgating their rule. 
 

4.2.4 Concise Explanatory Statement 

When filing a Final Rule, each agency must issue a concise, explanatory statement 
(R.I. Gen. Laws § 42-35-2.6). The statement must contain the following: 
 

1. Reasons for the Adoption, Amendment, or Repeal; 
 

2. Reasons for not accepting arguments made in testimony or comments; 
 

3. Reasons for changes in text between the Proposed and Final Rule filed; and 
 

4. Regulatory analysis prepared under R.I. Gen. Laws § 42-35-2.9. 
 
The Department of State has provided a sample Concise Explanatory Statement, 
intended as a tool for agencies’ use when filing their rule as required in R.I. Gen. Laws 
§ 42-35-2.6. Agencies are not required to use the sample when filing their rule. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.htm
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.6.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.6.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.6.htm
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5 FORMATTING REGULATIONS  
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5.1 Required Formatting 

Formatting requirements ensure rules display interactively correctly in the RICR and 
so that the RICR has a uniform style for public accessibility using ADA standards. 
 
 

5.1.1 Track Changes 

All text changes must be notated using Microsoft Office’s Track Changes feature: 
 

• Adoptions must display all text underlined, as the entire document is new text. 
 

• Amendments must display a combination of underlined and struck out text. 
 

• Repeals must display all text struck out, as the entire document is deleted text. 
 
Track Changes will display the following once text is added, moved, or deleted: 
 

• Added text: Example 
 

• Moved text – original location (if text is highlighted and dragged): Example 
 

• Moved text – new location (if text is highlighted and dragged): Example 
 

• Deleted text: Example 

 
To turn on Track Changes, click Review > Track Changes > For Everyone: 
 

 
 
Before making any changes, click Review > All Markup > No Markup for ease of use: 
 

 
 
This will show what the rule will look like once all changes are accepted so the 
document is easier to edit. Switch back to All Markup for the changes to display. 
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5.1.1.1 Track Changes FAQ 

What if an adoption didn’t use Track Changes? 

To fix a document to ensure all text is underlined using Track Changes: 
 

1. If already on, turn off Track Changes by clicking Review > Track Changes: 
 

 
 

2. Highlight all text (Ctrl+a) and cut (Ctrl+x) to delete and copy the text. 
 

3. Turn on Track Changes by clicking Review > Track Changes (see above). 
 

4. Paste (Ctrl+v) the text back into the document, which will underline all text. 

What if an amendment didn’t use Track Changes? 

The easiest way to ensure text is correctly underlined or struck out using Track 
Changes is to download the rule from the RICR Filing System again (§ 5.1.2.2 of 
this Guide), turn Track Changes on, and manually replicate all changes from the 
previously used document to the new document. 

What if a repeal didn’t use Track Changes? 

To fix a document to ensure all text is struck out using Track Changes: 
 

1. Highlight all text (Ctrl+a) and cut (Ctrl+x) to delete and copy the text. 
 

2. Turn off Track Changes by clicking Review > Track Changes: 
 

 
 

3. Paste (Ctrl+v) the text back into the document. 
 

4. Turn on Track Changes by clicking Review > Track Changes (see above). 
 

5. Highlight all text (Ctrl+a) and press Delete or Backspace on the keyboard, 
which will strike out all text. 
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5.1.2 RICR Template 

The RICR Template has regulation document, margin, and font requirements built in: 
 

Document Requirements: 

Rules must use the Word Document file type (.docx) upon saving. 

Margin Requirements: 

Rules must be set to use Normal (1”) margins. To verify or to fix the margins: 
 

1. Click Layout > Margins, and if not set to Normal, click within the text, highlight 
all text (Ctrl+a), and click Margins > Normal to correct the margins: 
 

 

Font Requirements: 

Each RICR style (§ 5.1.3 of this Guide) will automatically format text with the required 
font, font color, font style, font size, and font spacing. 
 
The below is for informational purposes only to identify when a style is not correctly 
implemented, not to be manually implemented within a rule. RICR styles are required. 
 

 
RICR 
Number 

RICR Title 
Number 

RICR 
Chapter 
Number 

RICR 
Subheading/ 
Subchapter 

RICR 
Part 

RICR 
Heading 1 

RICR 
Paragraph 
1-6 

Font: Arial 

Color: Black (Hex #000000) 

Style: Bold Bold Bold Bold  Bold  

Size: 12 14 12 12 12 14 12 

Spacing: 

Before: 
12 pt 
 

After: 
10 pt 

Before: 
12 pt 
 

After: 
0 pt 

Before: 
12 pt 
 

After: 
6 pt 

Before: 
12 pt 
 

After: 
6 pt 

Before: 
12 pt 
 

After: 
6 pt 

Before: 
12 pt 
 

After: 
3 pt 

Before: 
12 pt 
 

After: 
0 pt 

https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
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5.1.2.1 Proposed Adoptions 

Adoptions must be drafted using the RICR Template. Click here to download. 
 

If an adoption is drafted outside of the RICR Template, contact the Administrative 
Records Office for assistance merging the drafted text into the RICR Template. 
 

NOTE: Emergency Rules use the Proposed Rule process only, and will not 
have a Final Rule draft, as the document must display the changes 
between the previous promulgation, if applicable, and the new 
Emergency Rule in the RICR. 
 

APA Exempt Rules use the Proposed Rule process to draft the rule, but 
it uses the Final Regulation process to save the rule, as the document 
must display the rule with all changes accepted in the RICR. See § 
5.1.2.4 of this Guide for saving procedures. 

 
To get started: 
 

1. Open the RICR Template and replace the first five lines with the applicable 
regulation information in uppercase text: 
 

 
 

a. Replace the first line with the RICR Citation. 
(i.e., 216-RICR-10-05-1) 
 

b. Replace the second line with the Title Number and Agency Name. 
(i.e., TITLE 216 – DEPARTMENT OF HEALTH) 
 

c. Replace the third line with the Chapter Number and Name. 
(i.e., CHAPTER 10 – PUBLIC HEALTH ADMINISTRATION) 
 

d. Replace the fourth line with the Subchapter Number and Name. 
(i.e., SUBCHAPTER 05 – PRACTICES AND PROCEDURES) 

https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
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e. Replace the fifth line with what the Part Number and Name will be*. 
(i.e., PART 1 – ACCESS TO PUBLIC RECORDS) 
 

*Always check the RICR Filing System to ensure the Part number is 
available before drafting the rule as detailed in § 6.3 of this Guide. 
 

2. For each new section, replace # with the Part number and replace Heading 
with the section name (i.e., #.1  Heading > 7.1  Authority): 
 

 
 

3. OPTIONAL: If using subsections, replace # with the Part Number and 
replace Subheading with the subsection name (i.e., X.1.1  Subheading > 
7.1.1  Use): 
 

 
 

4. Add each paragraph of text (a.k.a. section) based on the correct paragraph 
level (§ 5.1.3.1 of this Guide) using the corresponding enumeration 
designation (§ 5.1.4 of this Guide): 
 

 
 

a. Every section must have its own corresponding enumeration 
designation for citation purposes and to display correctly in the RICR. 

 
5. Hit Enter or Return on the keyboard once to start a new section. 

Do not insert an additional hard return in between paragraphs by hitting 
Enter or Return on the keyboard twice. 
 

6. Save As using the correct file name (§ 5.1.5 of this Guide). 
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Do not accept any changes before uploading to the RICR Filing System. 
 

By leaving on Track Changes, this displays the proposed changes and ensures the 
final Rulemaking Record will include the changes between the Proposed and Final 
Regulations. 
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5.1.2.2 Proposed Amendments 

Amendments must be drafted using the currently active promulgation’s Final Rule 
document. 
 

NOTE: Emergency Rules use the Proposed Rule process only, and will not 
have a Final Rule draft, as the document must display the changes 
between the previous promulgation, if applicable, and the new 
Emergency Rule in the RICR. 
 

APA Exempt Rules use the Proposed Rule process to draft the rule, but 
it uses the Final Regulation process to save the rule, as the document 
must display the rule with all changes accepted in the RICR. See § 
5.1.2.4 of this Guide for saving procedures. 

 
By downloading the document directly from the RICR Filing System, this ensures 
the correct document is used to draft the new promulgation for the same Part. 
 
To download and use the currently active promulgation’s Final Rule document: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the Part in the Current Rules tab by clicking the Title, Chapter, and 
Subchapter. 
 

3. Click the Download Document icon next to the Part name (paper with blue 
arrow): 
 

 
 

4. Open the document, ensure Track Changes is turned on (§ 5.1.1 of this 
Guide), and add, edit, or delete text as needed. 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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5. If adding new sections, add based on the correct paragraph level (§ 5.1.3.1 
of this Guide) using the corresponding enumeration designation (§ 5.1.4 of 
this Guide): 
 

 
 

a. Every section must have its own corresponding enumeration 
designation for citation purposes and to display correctly in the RICR. 
 

b. Ensure enumeration designations and citations are updated as 
needed if sections are added between other sections. 
 

c. Hit Enter or Return on the keyboard once to start a new section. 
Do not insert an additional hard return in between paragraphs. 

 
6. If deleting entire sections, replace section text with “Repealed.” to ensure 

citations are not invalidated by renumbering the entire rule. For example: 
 

3.2 Repealed. 
 

7. Save As using the correct file name (§ 5.1.5 of this Guide). 
 
Do not accept any changes before uploading to the RICR Filing System. 
 

By leaving on Track Changes, this displays the proposed changes and ensures the 
final Rulemaking Record includes the changes between the currently active 
promulgation and the Final Regulation and additionally between the Proposed 
and Final Regulations. 
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5.1.2.3 Proposed Repeals 

Repeals must be drafted using the currently active promulgation’s Final Rule 
document. 
 

NOTE: Emergency Rules use the Proposed Rule process only, and will not 
have a Final Rule draft, as the document must display the changes 
between the previous promulgation, if applicable, and the new 
Emergency Rule in the RICR. 
 

APA Exempt Rules use the Proposed Rule process to draft the rule, but 
it uses the Final Regulation process to save the rule, as the document 
must display the rule with all changes accepted in the RICR. See § 
5.1.2.4 of this Guide for saving procedures. 

 
By downloading the document directly from the RICR Filing System, this ensures 
the correct document is used to draft the new promulgation for the same Part. 
 
To download and use the currently active promulgation’s Final Rule document: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the Part in the Current Rules tab by clicking the Title, Chapter, and 
Subchapter. 
 

3. Click the Download Document icon next to the Part name (paper with blue 
arrow): 
 

 
 

4. Open the document, ensure Track Changes is turned on (§ 5.1.1 of this 
Guide), highlight the text (Ctrl+a), and hit Delete or Backspace on the 
keyboard to delete all text. 
 

5. Save As using the correct file name (§ 5.1.5 of this Guide). 
 
Do not accept any changes before uploading to the RICR Filing System. 
 

By leaving on Track Changes, this displays the proposed changes and ensures the 

https://rules.sos.ri.gov/
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final Rulemaking Record includes the changes between the currently active 
promulgation and the Final Regulation and additionally between the Proposed 
and Final Regulations. 
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5.1.2.4 Final Regulations 

Final Regulations must be drafted using the exact Proposed Rule that was 
displayed in the RICR during the Public Comment Period, if applicable. 
 

• If formatting changes were not required from the Administrative Records 
Office (ARO), this means the agency must use the document that was 
uploaded in the RICR Filing System for the Public Comment Period. 

 
• If formatting changes were required from the ARO, this means the 

document used for the Public Comment Period is different than what the 
agency uploaded, and the correct document must first be downloaded to 
draft the Final Regulation. 

 
To identify which document to use: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the Rule within the Work Queue tab by clicking the Title, Chapter, 
Subchapter, and Part: 
 

 
 

3. Click the Details tab and scroll to view the Workflow Request and Outcome 
Notes: 
 

 

https://rules.sos.ri.gov/
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4. The most recent notes will be at the bottom: 
 

If the note indicates formatting changes were not required, use the 
document the agency uploaded for the Public Comment Period to draft the 
Final Regulation. 
 

If the note indicates formatting changes were required, complete the 
following to download and use the correct document. 
 

a. Click the Upload Documents icon (piece of paper with blue arrow): 
 

 
 

b. Download the most recent Regulation Word Document (file at the 
top of the list ending in .docx) to draft the Final Regulation. 

 
Once the correct document is identified to draft the Final Regulation, use the 
steps in § 5.1.2.2 of this Guide to amend the text (not permitted for Direct Final 
Rulemaking). 
 
Save two versions of the Final Rule: 
 

1. Track Changes Version (with changes not yet accepted); and 
 

2. Clean Version (with all changes accepted). 
 
Use the required filing naming conventions to differentiate between the two Final 
Rules saved (§ 5.1.5 of this Guide). 
 
By uploading a version with Track Changes, this ensures the final Rulemaking 
Record includes the changes between the Proposed and Final Regulations by the 
agency, and the formatting changes by the Department of State. 
 

During the final rule review, the ARO will: 
 

1. Apply any required formatting corrections to the agency’s Clean Version; 
 

2. Upload a Track Changes Version with the formatting corrections; and 
 

3. Upload a Clean Version with the formatting changes. 
 

The ARO’s Clean Version is the Final Regulation version that displays in the RICR. 
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5.1.3 RICR Styles 

All regulation text must use a corresponding RICR style to format the text. The RICR 
styles must be applied using the Styles window within the Home tab ribbon, not the 
Design tab ribbon, within Microsoft Word. 
 
To open the Styles window: 
 

1. Click the small arrow at the bottom-right corner of the Styles section: 
 

 
 

2. This will pop out the Styles window. If the Styles window is floating above text, 
click and drag the Styles window to the upper-right side of the Microsoft Word 
document to lock the window to the sidebar to prevent the floating window 
from covering text: 
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5.1.3.1 Required Styles 

All approved RICR styles begin with “RICR” then the name of the style: 
 

RICR Style Name Used For Additional Information 

RICR Number RICR citation Format: ###-RICR-##-##-# 

RICR Title Number 
Agency number & 
name  

Title number set by the ARO 
ex. 280 - Department of Revenue 

RICR Chapter Number 
Function number & 
name 

Do not use leading zeros 
ex. 20 - Division of Taxation 

RICR Subheading/Subchapter Topic number & name 
Use leading zeros 
ex. 05 - Banks 

RICR Part Rule number & name 
Do not use leading zeros 
ex. 1 - Bank Deposits Tax 

RICR Heading 1 Heading title  Starting with Part#.1 (i.e., 2.1) 

RICR Subheading/Subchapter* Subheading title Starting with Part#.#.1 (i.e., 2.3.1) 

RICR Paragraph 1 Section level 1 text Starting with “A.” 

RICR Paragraph 2* Section level 2 text Starting with “1.” 

RICR Paragraph 3* Section level 3 text Starting with “a.” 

RICR Paragraph 4* Section level 4 text Starting with “(1)” 

RICR Paragraph 5** Section level 5 text Starting with “(A)” 

RICR Paragraph 6** Section level 6 text Starting with “(i)” 

RICR Text Table text For use within tables only 

 

*Optional level, available to use if needed. 
 

**Agencies should make every attempt to limit the number of section levels to no more 
than four (4) paragraph levels to reduce regulatory volume while maintaining readability. 

 
Section levels must use the letter/number and include a period after or be within 
parentheses, not both. No period should be added if the style uses parentheses 
(i.e., use “(1)”, not “(1.)”). 
 
Any style not listed above is prohibited, as the text will not display in the RICR. 
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5.1.3.2 Using Styles 

There are two ways to apply RICR styles, to either apply the style first before typing 
or to apply it after typing or pasting text. 
 
To apply the RICR style before typing text: 
 

1. Click the corresponding RICR style in the Styles window to apply the 
required formatting: 
 

 
 

2. Type text as needed. 

To apply the RICR style after typing or pasting text: 
 

1. Highlight the text. 
 

2. Click the corresponding RICR style in the Styles window to apply the 
required formatting: 
 

 
 

3. Depending on what formatting may have carried over from pasting, the 
RICR style may have to be clicked twice to first remove previous formatting 
and then again to apply the correct formatting. 
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5.1.3.3 Style Exceptions 

Bold, italics, and underlining may not be used for emphasis. Only the following 
limited exceptions are permitted: 
 

• Italics for Latin, legal, scientific, or medical terminology; or 
 

• Bold for headings within tables. 
 

NOTE:  For ease of use, complete the following steps after all other content is 
added, edited, or removed, to avoid repeating the process of 
applying limited exceptions multiple times. 

 
To apply a limited exception: 
 

1. Click the A icon with a green checkmark at the bottom of the Styles window 
to manage styles: 
 

 
 

2. In the Restrict tab, uncheck Limit formatting to permitted styles, and click 
OK to temporarily allow non-RICR styling: 
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3. Highlight the applicable text and apply the exception formatting, as 
permitted above. 
 

4. After all text has had exception formatting applied, click the A icon with a 
green checkmark at the bottom of the Styles window to manage styles 
again to reset the required RICR styles: 
 

 
 

5. In the Restrict tab, check Limit formatting to permitted styles, and click OK 
to continue editing the document: 
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5.1.3.4 RICR Styles FAQ 

What if extra non-RICR styles are displaying? 
 

If extra styles are displayed in the Styles window, complete the following to lock 
the document to only display the required RICR styles for ease of use: 
 

1. At the bottom of the Styles window, click Options: 
 

 
 

2. In the Select styles to show dropdown, select In current document, and 
click OK to display all styles currently used in the document. 
 

 
 

3. Click the A icon with a green checkmark at the bottom of the Styles window 
to manage styles: 
 

 
 

4. In the Restrict tab, check Limit formatting to permitted styles, and click OK 
to continue editing the document: 
 

 
 

5. If additional styles still display, email the Administrative Records Office 
(ARO) to update the document to remove the additional styles. 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
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What if there are missing RICR styles? 

If there are missing RICR styles after completing the above, there are two options: 
 

• Adoptions & Repeals 
 

Download the RICR Template and copy and paste the text into the 
downloaded document using the steps found in § 5.1.1.1 of this Guide to 
ensure all text is either underlined for adoptions or struck out for repeals. 
 

• Amendments 
 

Email the document to the ARO requesting all missing RICR Styles to be 
merged into that document. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://www.sos.ri.gov/divisions/open-government-center/rules-and-regulations/filing-resources
mailto:rulesregs@sos.ri.gov
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5.1.4 Section Enumeration Designations 

Each section (paragraph) in a rule must have its own corresponding number or letter 
designation for citation purposes and to display correctly in the interactive RICR. 
 
Section levels must use the associated letter/number and either include a period after 
or be within parentheses, as listed in the table in § 5.1.3.1 of this Guide. No period 
should be added if within parentheses (i.e., use “(1)”, not “(1.)”). 
 
Enumeration designations must be sequential (i.e., “A.”, “B.”, “C.”, etc.). Do not skip 
letters or numbers when assigning initial section enumeration designations within 
Adoptions, or when adding sections in Amendments. 
 
 

5.1.4.1 Adding Enumeration Designations 

Enumeration designations must be added manually, as automatic numbering is 
not permitted (§ 5.3.1 of this Guide).  
 
To add an enumeration designation: 
 

1. Use the table in § 5.1.3.1 of this Guide to determine the starting 
enumeration designation for the heading or paragraph level needed. 
 

2. Click the location in the document where text needs to go and apply the 
associated RICR style for the heading or paragraph level. 
 

3. Type the starting enumeration designation, as noted in the table. 
Do not add a space after the enumeration designation or before the text. 
 

4. Insert one (1) Tab on the keyboard after the enumeration designation to 
align the section text. 
Do not use the ruler or a tab before the enumeration designation to align. 
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5. Type text to complete the section or paste text and apply the correct RICR 
style (§ 5.1.3.2 of this Guide). 
 

a. The subsequent lines of text in the section will automatically indent, 
and no additional inserted tabs are necessary until the next section. 
 

6. Repeat steps 1 through 5 as needed, increasing the enumeration 
designation sequentially for each subsequent section. 

 
a. For letters, if sections surpass the end of the alphabet, continue by 

using double letters sequentially (i.e., “AA.”, “BB.”, “CC.”, etc.). 

When deleting an entire section: 
 

1. Keep the enumeration designation. 
 

2. Replace section text with “Repealed.” to ensure citations are not invalidated 
by renumbering the entire rule. For example: 

 

3.2 Repealed. 
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5.1.5 File Naming Conventions 

For ease of identification and to distinguish files within the RICR Filing System, use the 
following file naming conventions, which will also assist in agency folder organization. 
 
Adoptions 
 

• Drafts: ###-RICR-##-##-#_DATE_ADT_v# 
 

ex. 100-RICR-10-10-1_2025-01-01_ADT_v2.docx 
 

• *Proposed: ###-RICR-##-##-#_DATE_ADT_AGYProposed 
 

ex. 100-RICR-10-10-1_2025-01-01_ADT_AGYProposed.docx 
 

• *Final – Track Changes Version: ###-RICR-##-##-#_DATE_ADT_AGYFinal_TC 
ex. 100-RICR-10-10-1_2025-01-01_ADT_AGYFinal_TC.docx 
 

• *Final – Clean Version: ###-RICR-##-##-#_DATE_ADT_AGYFinal 
ex. 100-RICR-10-10-1_2025-01-01_ADT_AGYFinal.docx 

 
Amendments 
 

• Drafts: ###-RICR-##-##-#_DATE_AMD_v# 
 

ex. 100-RICR-10-10-1_2025-01-01_AMD_v2.docx 
 

• *Proposed: ###-RICR-##-##-#_DATE_ADT_AMDProposed 
 

ex. 100-RICR-10-10-1_2025-01-01_AMD_AGYProposed.docx 
 

• *Final – Track Changes Version: ###-RICR-##-##-#_DATE_ADT_AMDFinal 
ex. 100-RICR-10-10-1_2025-01-01_AMD_AGYFinal_TC.docx 
 

• *Final – Clean Version: ###-RICR-##-##-#_DATE_ADT_AMDFinal_TC 
ex. 100-RICR-10-10-1_2025-01-01_AMD_AGYFinal.docx 

 
Repeals 
 

• Drafts: ###-RICR-##-##-#_DATE_RPL_v# 
 

ex. 100-RICR-10-10-1_2025-01-01_RPL_v2.docx 
 

• *Proposed: ###-RICR-##-##-#_DATE_RPL_AGYProposed 
 

ex. 100-RICR-10-10-1_2025-01-01_RPL_AGYProposed.docx 
 

• *Final – Track Changes Version: ###-RICR-##-##-#_DATE_RPL_AGYFinal_TC 
ex. 100-RICR-10-10-1_2025-01-01_RPL_AGYFinal_TC.docx 
 

• *Final – Clean Version: ###-RICR-##-##-#_DATE_RPL_AGYFinal 
ex. 100-RICR-10-10-1_2025-01-01_RPL_AGYFinal.docx 

 
*Files are listed in upload order for the RICR Filing System. 
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5.1.6 How to Verify Required Formatting 

To verify all text is using an RICR style and every section has an enumeration 
designation: 
 

1. Click Options>Advanced 
2. Scroll down to Display 
3. Set the Style Area Pane to 1” or more. 

 
4. Click View > Outline: 

 

 
 

5. Scroll to check that all text has the correct RICR style applied (first column) and 
every section has an enumeration designation (second column): 
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6. To exit back to normal view, click within the line of text to the right of the 

second column to see it in normal view and click Close Outline View: 
 

 
 

7. Repeat steps 1 through 3 to fix each section as necessary to use the correct 
RICR style and add any missing enumeration designations. 
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5.2 Permitted Formatting 

The following content may be used within rules. If used, the content must be 
formatted as described below to display the rule correctly in the RICR to view the rule 
interactively and to ensure consistency across all promulgated regulations. 
 
For questions regarding permitted content, contact the Office of Management and 
Budget at omb.regsubmission@omb.ri.gov. 
 
For questions regarding the formatting of permitted content, contact the 
Administrative Records Office at rulesregs@sos.ri.gov. 
 
 

5.2.1 Citations 

Citations are permitted if formatted per § 5.2.1.3 of this Guide to ensure a consistent, 
uniform system throughout the RICR so other agencies and the public can easily 
identify and locate the original source. 
 
The citation formats outlined have taken into consideration: 
 

• Ease for the non-lawyer reader; 
 

• Ease for the non-lawyer agency drafter; 
 

• Ease for the out-of-state reader; 
 

• How other states cite within their rules; and 
 

• The requirements of the Rhode Island Administrative Procedures Act. 
 

NOTE:  Many citations include the section symbol (§). The section symbol must 
always have a space before and after when used. To insert a section 
symbol, use shortcut Alt+0167 on the keyboard. 
 
If citing multiple sections, the citation must include two section symbols 
with no space between (i.e., R.I. Gen. Laws §§ 42-35-1 and 42-35-3.2). 

 
 
 
 
 
 

mailto:omb.regsubmission@omb.ri.gov
mailto:rulesregs@sos.ri.gov
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5.2.1.1 Direct Citation vs Incorporation by Reference 

The Rhode Island Administrative Procedures Act (APA) allows agencies to 
incorporate certain source materials by reference (§ 5.2.1.2 of this Guide). 
 
To determine if materials should be directly cited or incorporated by reference, 
the type of source material needs to be identified. The following source materials 
may be incorporated by reference without having to include the incorporated 
material in full (R.I. Gen. Laws §§ 42-35-3.2(a)(1) through (3)): 
 

(1) Federal rules, codes, or standards published in full in the Federal 
Register or the Code of Federal Regulations; 
 

(2) Federal rules, codes, or standards that have been properly 
incorporated by reference in the Federal Register as part of a duly 
promulgated final rule or in the Code of Federal Regulations 
pursuant to federal legal requirements; and 
 

(3) Published codes, standards or guidelines of any nationally 
recognized scientific or technical association or organization. 

 
This means the following published sources may be incorporated by reference: 
 

• Code of Federal Regulations (C.F.R); 
 

• United States Code (U.S.C.); 
 

• Materials incorporated in the C.F.R.; or 
 

• Codes, standards or guidelines published by nationally recognized 
scientific or technical associations or organizations. 

 
By incorporating these materials by reference, this allows agencies to give any of 
the above full legal effect and force of law so that the agency can enforce 
compliance. 
 
Only the following published sources may be cited without formally incorporating: 
 

• Rhode Island statute; 
 

• Rhode Island regulation; or 
 

• Federal statute. 
 
Since State and Federal statutes already have the force of law behind them, they 
do not need to be incorporated formally. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-3.2.htm


 
 
 
 

 76 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

Since Rhode Island Regulations are analogous to state statutes, in that they 
already have the force of law behind them on a statewide level, they do not need 
to be incorporated formally, which helps to avoid conflicting rules in the RICR. 
 

NOTE:  Guidance documents, agency policies, or agency guidelines may not 
be cited or incorporated by reference. 

 
 

5.2.1.2 Incorporation by Reference 

The APA allows for agencies to incorporate certain materials by reference without 
having to publish the entirety of the material within a rule (R.I. Gen. Laws § 42-35-
3.2). 
 
If agencies incorporate materials by reference within a regulation, that agency 
“shall maintain a copy of the material and shall allow public inspection of the 
material and provide copies of any non-copyrighted material to the public… If any 
material to be incorporated by reference has been copyrighted, the agency shall 
upon request provide information about the publisher and the citation to the 
material.” (R.I. Gen. Laws § 42-35-3.2(e)) 
 
 

5.2.1.2.1 How to Incorporate Materials by Reference 

To incorporate source materials by reference: 
 

1. Create a section labeled, “Incorporated Materials”. 
 

NOTE:  It is recommended for the consistency of regulations 
published in the RICR to insert this section between the 
“Authority” and “Definition” sections of a rule. 
 
However, there may be circumstances where it is 
appropriate to incorporate materials by reference in the 
body of the Regulation. For example, when a material is 
referenced only once within that Part. 

 
2. Create subsections for each source material to be incorporated. 

 
3. Use the following language: 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-3.2.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-3.2.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-3.2.htm
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“These Regulations hereby adopt and incorporate [citation (date)] by 
reference, not including any further editions or amendments thereof 
and only to the extent that the provisions therein are not inconsistent 
with these Regulations.” 
 

4. Replace the bracketed language with: 
 

a. The citation (§ 5.2.1.3 of this Guide); and 
 

i. If citing materials published by nationally recognized 
scientific or technical associations or organizations, per 
the APA, include both the name of the association or 
organization and the title of the material in the citation. 
 

b. The date of the code edition or scientific/technical material being 
cited in parentheses directly following the citation. 

 

NOTE:  The most recent version of the source material should be 
incorporated. If a rule references a prior year, changing the 
year is a substantive change that requires an Amendment. 

 
Example Incorporated Materials Section: 
 

3.3 Incorporated Materials 
 

A. These Regulations hereby adopt and incorporate 16 C.F.R. § 444.1 
(2014) by reference, not including any further editions or 
amendments thereof and only to the extent that the provisions 
therein are not inconsistent with these Regulations. 
 

B. These Regulations hereby adopt and incorporate the American 
Medical Association’s “Standards for Taking Blood Samples” (2001) 
by reference, not including any further editions or amendments 
thereof and only to the extent that the provisions therein are not 
inconsistent with these Regulations. 
 

C. These Regulations hereby adopt and incorporate the “National 
Geological Society Guidelines for the Safe Gemstone Excavation” 
(2015) by reference, not including any further editions or 
amendments thereof and only to the extent that the provisions 
therein are not inconsistent with these Regulations. 
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5.2.1.2.2 How to Cite Incorporated Materials 

Once a source material is incorporated by reference, it may be cited within the 
body of the rule by citing the Incorporated Materials section. 
 
To cite to the Incorporated Materials section: 
 

1. Add the following language: 
 
“[text referencing source material], incorporated above at § [number] of 
this Part.” 
 

2. Replace the bracketed language with: 
 

a. The leading text that references the source material; and 
 

b. The Subsection number of the specific incorporated material. 
 

Examples of Citing the Incorporated Materials Section: 
 

(A) Phlebotomists must maintain their syringes in the manner prescribed 
in “Standards for taking Blood Samples”, incorporated above at § 
3.3(B) of this Part. 

 

(B) Geologists must mine for diamonds in accordance with “National 
Geological Society Guidelines for the Safe Gemstone Excavation”, 
incorporated above at § 3.3(C) of this Part. 
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5.2.1.3 Direct Citation Formats 

When including a direct citation within a rule, use the tables found in §§ 5.2.1.3.1 – 
5.2.1.3.6 of this Guide to determine how to format the citation. 
 

NOTE:  If citing a rule that has not yet been filed with the Department of State 
and published in the RICR, cite the title of the rule enclosed in 
quotation marks instead of the citation formats listed below. 
 

For example: 
“Department of Health Rules and Regulations Regarding Health 
Care Workers” 

 

Once the rule is filed and published in the RICR, the citation may then 
be changed to the formats found in the below tables via a Technical 
Revision (§ 3.3.6 of this Guide). 

 
 

5.2.1.3.1 RICR: Same Title 

For all citations to the Rhode Island Code of Regulations within the same Title 
as the Part the citation is in, use the following tables to determine the correct 
required citation format: 
 

Within the Same Title 

Component Format Citation Formatting Example 

Title this Title this Title 

Chapter Chapter ## of this Title Chapter 20 of this Title 

Subchapter Subchapter ##-## of this Title Subchapter 20-15 of this Title 

Part Part ##-##-# of this Title Part 20-15-7 of this Title 

Section § ##-##-#.# of this Title § 20-15-7.2 of this Title 

Subsection § ##-##-#.#(X) of this Title § 20-15-7.2(A) of this Title 

Additional 
Subsections 

§ ##-##-#.#(X)(#)(x)(#)(X)(x) of this 
Title 

§ 20-15-7.2(A)(1)(a)(1)(A)(i) of this 
Title 
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Within the Same Chapter 

Component Format Citation Formatting Example 

Chapter this Chapter this Chapter 

Subchapter Subchapter ## of this Chapter Subchapter 15 of this Chapter 

Part Part ##-# of this Chapter Part 15-7 of this Chapter 

Section § ##-#.# of this Chapter § 15-7.2 of this Chapter 

Subsection § ##-#.#(X) of this Chapter § 15-7.2(A) of this Chapter 

Additional 
Subsections 

§ ##-#.#(X)(#)(x)(#)(X)(x) of this 
Chapter 

§ 15-7.2(A)(1)(a)(1)(A)(i) of this 
Chapter 

 
 

Within the Same Subchapter 

Component Format Citation Formatting Example 

Subchapter this Subchapter this Subchapter 

Part Part # of this Subchapter Part 7 of this Subchapter 

Section § #.# of this Subchapter § 7.2 of this Subchapter 

Subsection § #.#(X) of this Subchapter § 7.2(A) of this Subchapter 

Additional 
Subsections 

§ #.#(X)(#)(x)(#)(X)(x) of this 
Subchapter 

§ 7.2(A)(1)(a)(1)(A)(i) of this 
Subchapter 

 
 

Within the Same Part 

Component Format Citation Formatting Example 

Part this Part this Part 

Section § # of this Part § 2 of this Part 

Subsection § #(X) of this Part § 2(A) of this Part 

Additional 
Subsections 

§ #(X)(#)(x)(#)(X)(x) of this Part § 2(A)(1)(a)(1)(A)(i) of this Part 
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Within the Same Section or Subsection 

Component Format Citation Formatting Example 

Section this Section this Section 

Subsection this Subsection this Subsection 

Specific Section § # of this Part § 2 of this Part 

Specific Subsection § #(X) of this Part § 2(A) of this Part 

Specific Additional 
Subsections 

§ #(X)(#)(x)(#)(X)(x) of this Part § 2(A)(1)(a)(1)(A)(i) of this Part 

 
 

5.2.1.3.2 RICR: Different Title 

For all citations to the Rhode Island Code of Regulations within a different Title 
than the Part the citation is in, use the following table to determine the correct 
required citation format: 
 

Component Format Citation Formatting Example 

Title Title ### of this Code Title 216 of this Code 

Chapter Chapter ###-## of this Code Chapter 216-20 of this Code 

Subchapter Subchapter ###-##-## of this Code Subchapter 216-20-15 of this Code 

Part ###-RICR-##-##-# 216-RICR-20-15-7 

Section ###-RICR-##-##-#.# 216-RICR-20-15-7.2 

Subsection ###-RICR-##-##-#.#(X) 216-RICR-20-15-7.2(A) 

Additional 
Subsections 

###-RICR-##-##-#.#(X)(#)(x)(#) 
(X)(x) 

216-RICR-20-15-7.2(A)(1)(a)(1) 
(A)(i) 
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5.2.1.3.1 Rhode Island Statutes 

Component Format Citation Formatting Example 

Title R.I. Gen. Laws Title # R.I. Gen. Laws Title 9 

Chapter R.I. Gen. Laws Chapter #-# R.I. Gen. Laws Chapter 9-19 

Section R.I. Gen. Laws § #-#-# R.I. Gen. Laws § 9-19-39 

Subsection R.I. Gen. Laws § #-#-#(x) R.I. Gen. Laws § 9-19-39(b) 

Additional 
Subsections 

R.I. Gen. Laws § #-#-#(x)(#) R.I. Gen. Laws § 9-19-39(b)(4) 

 
 

5.2.1.3.2 Rhode Island Public Laws 

Style Format Citation Formatting Example 

Full [name], Pub. Laws [session #]-[chapter 
#] 

An Act Relating to Towns and Cities – 
Retirement of Municipal Employees, 
Pub. Laws 10-275 

Short Pub. Laws [session #]-[chapter #] Pub. Laws 10-275 

 
 

5.2.1.3.3 Code of Federal Regulations 

Component Format Citation Formatting Example 

Title C.F.R. Title # C.F.R. Title 7 

Subtitle # C.F.R. Subtitle X 7 C.F.R. Subtitle B 

Chapter # C.F.R. Subtitle X Chapter X 7 C.F.R. Subtitle B Chapter VIII 

Subchapter 
# C.F.R. Subtitle X Chapter X 
Subchapter X 

7 C.F.R. Subtitle B Chapter VIII 
Subchapter A 

Part # C.F.R. Part # 7 C.F.R. Part 868 

Subpart # C.F.R. Part # Subpart X 7 C.F.R. Part 868 Subpart C 

Section # C.F.R. § #.# 7 C.F.R. § 868.208 
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5.2.1.3.4 United States Code 

Component Format Citation Formatting Example 

Title U.S.C. Title # U.S.C. Title 7 

Chapter # U.S.C. Chapter # 7 U.S.C. Chapter 13 

Subchapter # U.S.C. Subchapter #-X 7 U.S.C. Subchapter 13-IV 

Section # U.S.C. § #x 7 U.S.C. § 347a 

Full Citation [name], # U.S.C. § #x 
Disadvantaged agricultural areas, 7 U.S.C. 
§ 347a 

 
 

5.2.1.3.5 Federal Public Laws 

Style Format Citation Formatting Example 

Full [name], Pub. L. No. [congress #]-[law #] Foreign Assistance Act of 1961, Pub. 
L. No. 87-195 

Short Pub. L. No. [congress #]-[law #] Pub. L. No. 87-195 

 
 

5.2.1.3.6 All Other Citations 

For any citations not listed in this Guide, refer to The Blue Book: A Uniform 
System of Citation for how to format all other citations to ensure a consistent, 
uniform system throughout the RICR so other agencies and the public can 
easily identify and locate the original source. 
 
If the citation includes an acronym, the full name should be written out in its 
first use within a Part and include the acronym in parentheses directly 
following. The acronym may then be used within the rest of the Part. 
 
 
 
 
 
 
 
 

https://www.legalbluebook.com/
https://www.legalbluebook.com/
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5.2.2 Definitions 

Definitions are only permitted if: 
 

1. The “Definitions” section is placed towards the beginning of the rule; 
 

2. Each definition is given its own section and enumeration designation; 
 

3. The sections are arranged alphabetically by the words or terms being defined; 
 

4. Each section includes: 
 

a. The words or terms being defined within quotation marks; 
 

b. Capitalizing the first letter of the first word within the quotation marks, 
with all subsequent words lowercase, unless the words or terms being 
defined are proper nouns; 
 

c. The word “means” directly following the words or terms being defined; 
and 
 

d. The definition of the words or terms directly following the word 
“means”. 
 

Definition Example: “Writing” means a record inscribed on a tangible medium. 
 
The following symbols may not be used within words or terms being defined: 
 

• Dashes [- or –]; 
 

• Slashes [/ or \]; or 
 

• Parentheses [( or )]. 
 
Instead, separate the words or terms by inserting the word “or” in between: 
 
Incorrect Correct 

“Individualized education plan/IEP” 
means… 

“Individualized education plan” or “IEP” 
means… 

 

NOTE:  Always cite the “Definitions” section itself within a rule, not to specific 
definitions. That way, if definitions need to be added when promulgating 
amendments, the “Definitions” section can be renumbered without 
invalidating citations to specific definitions. 
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5.2.3 Graphics, Figures, Images, and Maps 

Graphics, figures, images, and maps are only permitted if the visual: 
 

1. Fits within the margins of the rule; 
 

2. Is set to In Line with Text (right-click on visual > click Wrap Text > click to set 
style); 
 

3. Is treated as a section by using the next level paragraph RICR style to align the 
visual with the previous section text; 
 

a. For example, if the title or text above the visual uses RICR Paragraph 2, 
the visual itself should use RICR Paragraph 3 to align with the text, not 
the enumeration designation; 
 

4. Has a title for interactive display accessibility (see below note); and 
 

5. Includes Alt Text for accessibility and for those using assistive technology to 
access the rule: 
 

a. To insert Alt Text, right-click on the visual and click View Alt Text; 
 

b. Type text into the box describing the visual, its context to the 
section/rule, and include contact information where additional 
information can be requested and click X to close the side window. Do 
not use the “Generate alt text for me” feature. 
 

Alt Text Example: 
 

Visual: 
1. Structural Shoreline Protection Standards for Coastal Greenways 

   

Alt Text: “Image of land next to a building, the slope from the land to the coast, and 
the measurement for the coastal greenway, as described in § 2.2 of this Part. For 
additional information contact [insert contact information here].” 
 
Visuals that contain only text must be converted to text, when possible, for public 
accessibility and to be searchable. 
 
If visuals expand beyond the margins, they should be uploaded instead as an 
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appendix with a reference within the rule to view the appendix. 
 

NOTE:  Visuals should only be used when there is no other way of displaying the 
information, as they do not display interactively on the Part’s RICR 
webpage, and will only display within the downloadable PDF in the 
Regulation tab. 
 
Adding a title indicates a visual is there, and that the PDF should be 
viewed. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

 87 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

5.2.4 Hyperlinks 

Hyperlinks are permitted to link to other Parts in the RICR, the Code of Federal 
Regulations, United States Code, Guidance Documents, forms published on an 
agency website, or Incorporated Materials, as appropriate. 
 
Hyperlinks are only permitted if: 
 

1. Links direct the user to the correct, active webpage; and 

 

2. If linking to other Parts in the RICR, links go to the Part’s RICR webpage, not the 

PDF, to avoid continuity issues if/when a rule is amended. 
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5.2.5 Table of Contents 

Table of Contents (TOC) are only permitted if: 
 

1. The rule is longer than thirty (30) pages; 
 

2. The rule begins with the RICR citation information with the TOC inserted 
immediately following; 
 

3. A page break, using RICR Text style, is inserted immediately after the TOC and 
the first heading of the rule begins at the top of the next page. 
 

To insert a TOC: 

 

1. Click References > Table of Contents > choose a built-in TOC or custom TOC 

(if using custom TOC, Formats must be “From template”): 

 

 
 

2. All TOC text must use Arial font and black (hex #000000) font color. 
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5.2.6 Tables 

Tables are only permitted if the table: 
 

1. Uses the RICR style RICR Text; 
 

2. Fits within the margins of the document; 
 

3. Is aligned with the text of the section, not the enumeration designation; 
 

a. Correct: 

Table is aligned with the paragraph text, not the enumeration 
designation. 

Table Text 1 Table Text 2 

 
 
 
 

b. Incorrect: 

Table is aligned with the enumeration designation, not the paragraph text, and 
is not within the document margins. 

Table Text 1 Table Text 2 

 
 
 
 

4. Is added directly after text, and not as its own section (see below note); and 
 

5. Abides by the following options: 
 

Permitted Prohibited 

Borderless cells Partial borders 

Shading  

 

NOTE:  Tables must be inserted directly below text with no hard returns in 
between, not as its own section, otherwise it will not display interactively 
on the Part’s RICR webpage. 
 

If need be, the text before the table may be just a title (i.e., “Table 1”). 
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To create a new table, either complete step 1 or step 2: 
 

1. Click Insert > Table and use the simple table creator to select the correct 
number of rows and columns by dragging the mouse over the boxes and 
clicking once the correct number of rows and columns are highlighted: 

 

 
 

OR 
2. Click Insert > Table > Insert Table: 
 

 



 
 
 
 

 91 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. Enter the number of columns and rows, ensure the AutoFit behavior is 
set to Fixed column width: Auto, and click OK: 
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5.3 Prohibited Formatting 

5.3.1 Automatic Numbering 

Automatic numbering is not permitted. 
 
If the document tries to initiate automatic numbering, turn off that feature within the 
document by completing the following: 
 

1. Click File > Options and then click Proofing > AutoCorrect Options…: 
 

 
 

2. Click AutoCorrect Options > AutoFormat As You Type, uncheck Automatic 
bulleted lists and Automatic numbered lists, and click OK: 
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5.3.2 Bulleted Lists 

Bulleted lists are not permitted, including but not limited to: 
 

• Circle Bulleting 
 

o Hollow Circle Bulleting 
 

▪ Square Bulleting 
 

❖ Diamond Bulleting 

➢ Arrow Bulleting 
 

✓ Checkmark Bulleting 
 

- Dash Bulleting 
 

 Image Bulleting 

 
Lists must be formatted into separate sections with corresponding enumeration 
designations. For example: 
 
Incorrect 

 

A. The Department of State requires that all Filers: 
 

• Read the Agency Guide to Administrative Records;  
 

• Comply with the requirements found therein; and  
 

• Contact the Administrative Records Office with any questions. 
 

Correct 

 

A. The Department of State requires that all Filers: 
 
1. Read the Agency Guide: Administrative Records; 

 
2. Comply with the requirements found therein; and 

 
3. Contact the Administrative Records Office with any questions. 
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5.3.3 Enumerations Within Paragraphs 

Enumerations within paragraphs are not permitted. Enumerations must be formatted 
into separate sections with corresponding enumeration designations. For example: 
 
Incorrect 
 
A. The Department of State requires that all Filers (1) read Agency Guide: 

Administrative Records; (2) comply with the requirements found therein; and 
(3) contact the Administrative Records Office with any questions. 

 
Correct 

 
A. The Department of State requires that all Filers: 

 
1. Read Agency Guide: Administrative Records; 

 
2. Comply with the requirements found therein; and 

 
3. Contact the Administrative Records Office with any questions. 
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5.3.4 Headers/Footers 

Headers and footers are not permitted. 
 
 

5.3.5 Manual Alignment & Spacing 

Using the space bar, tab key, or ruler to manually align sections, or adding hard 
returns between sections, is not permitted. The RICR styles (§ 5.1.3 of this Guide) will 
automatically align text and add spacing between sections. 
 
 

5.3.6 Manual Emphasized Text 

Using formatting for emphasis is not permitted, including: 
 

1. Bolded text*; 
 

2. Italicized text*; and 
 

3. Underlined text. 
 

*Permitted only for noted RICR style exceptions (§ 5.1.3.3 of this Guide). 
 
 

5.3.7 Page Numbers 

Page numbers are not permitted within Final Rules. 
 
Page numbers within Proposed Rules are only permitted if: 
 

1. They are in the bottom-right corner of the footer; and 
 

2. They are removed before submitting the Final Rule. 
 
 

5.3.8 Watermarks 

Watermarks are not permitted within Final Rules. 
 
Watermarks within Proposed Rules are only permitted if: 
 

1. They do not impede the readability of the Rule; and 
 

2. They are removed before submitting the Final Rule. 
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6 RICR FILING SYSTE M 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

6 RICR FILING 
SYSTEM 
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6.1 RICR User Role Types 

There are three user role types within the RICR: the Agency Head (one (1) per entity), 
the Rules Coordinator (one (1) per entity), and Filers. 
 

NOTE:  For the cybersecurity of agency regulations, users must not share login 
information, which also ensures an accurate history log for each rule filed. 

 
 

6.1.1 Agency Head 

This user is the individual who has ultimate legal authority of the entity (R.I. Gen. Laws 
§ 42-35-1) and signs rules into effect. 
 
 

6.1.1.1 Updating the Agency Head 

Email the Administrative Records Office (ARO) to request and complete the 
corresponding form to update the Agency Head, including evidence of the 
change, to be signed by the entity’s legal authority. 
 
 

6.1.2 Rules Coordinator 

This user is the individual designated by the agency (R.I. Gen. Laws § 42-35-2.1) who 
has knowledge of the subjects of rules being proposed, maintains the rulemaking 
records, and responds to public inquiries, as their contact information is published on 
the Agency Info page in the RICR (§ 2.6 of this Guide). This individual is responsible 
for overseeing Filers, and for approving and advancing rules submitted by Filers. 
 
 

6.1.2.1 Updating the Rules Coordinator 

Email the ARO to request and complete the corresponding form to update the 
Rules Coordinator, to be signed by the entity’s head or legal authority. 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-1.htm
mailto:rulesregs@sos.ri.gov
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.1.htm
mailto:rulesregs@sos.ri.gov
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6.1.3 Filers 

Filers may be any person approved by the agency to participate in the rulemaking 
process. 
 
 

6.1.3.1 Adding Filers 

The Rules Coordinator or Agency Head can add Filers in the RICR System (§ 
6.4.3.2 of this Guide) or they may email the ARO to request and complete the 
corresponding form to add a Filer. Forms will only be accepted if submitted by the 
Rules Coordinator or Agency Head for the security of the agency’s Regulations. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

mailto:rulesregs@sos.ri.gov
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6.1.4 RICR User Role Permissions 

The below table indicates which user roles have permissions for each RICR function: 
 

RICR Function RICR Permissions Filer 
Rules 

Coordinator 
Agency 
Head 

RICR Views 

View Current Rules X X X 

View Work Queue X X X 

View Under Review X X X 

Rulemaking 

Create Proposed Rules X X X 

Terminate Proposed Rules X X X 

Approve Proposed Rules  X X 

Sign Final Rules   X 

Emergency Rules 

View Emergency Rules X X X 

Renew Emergency Rules by 60 days X X X 

Terminate active Emergency Rules X X X 

Periodic Refile Approve rules for Periodic Refile  X  

Guidance 
Documents 

View/create Guidance Documents X X X 

Remove Guidance Documents X X X 

Generate Guidance Document Index X X X 

Declaratory 
Orders 

Create Declaratory Orders X X X 

View/approve/reject Declaratory 
Orders 

 X X 

Generate Declaratory Order Index  X X 

Delete Declaratory Orders  X X 

Account/ 
User Information 

View My Account Details  X X 

Edit My Account Details  X X 

View users  X X 

Edit users  X X 

Add new Filer  X X 

RICR Structure 
View and create new Chapters  X X 

View and create new Subchapters  X X 

Notifications 
View notifications  X X 

Subscribe/unsubscribe to notifications  X X 
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6.1.5 Getting Started in the RICR Filing System 

The RICR Filing System allows users to file regulations, guidance documents, and 
declaratory orders with the Rhode Island Department of State (R.I. Gen. Laws 42-35). 
 
Click here to log in and view the RICR Filing System homepage: 
 

 

 
To File Regulations 
 

Use the following tabs and see § 6.3 of this Guide for step-by-step instructions: 
 

1. Current Rules tab to view current regulations or start a new promulgation; 
 

2. Work Queue tab to work on a proposed promulgation; and 
 

3. Under Review tab to view proposed promulgations that are not yet effective. 
 

 

 
To File Guidance Documents 
 

Click Manage > Guidance Document Index and see § 6.4.4 of this Guide for step-by-

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
https://rules.sos.ri.gov/


 
 
 
 

 101 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

step instructions: 
 

 

 
To File Declaratory Orders 
 

Click Manage > Declaratory Order and see § 6.4.5 of this Guide for step-by-step 
instructions: 
 

 

 

NOTE:  Different users will see different options under the Manage menu. See § 
6.1.4 of this Guide for more information regarding User Role Permissions. 
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6.2 RICR Rulemaking Processes 

6.2.1 RICR Rulemaking Processes Overview 

To identify in the RICR System which rulemaking step a rule is in, after logging in, click 
Work Queue > select a Rule > Approvals. The Rule is currently in the bolded step. 
 
The following tables indicate which user role must complete a rulemaking step in the 
RICR System. In some instances, multiple user roles can complete a step. It does not 
matter which user role completes the step, and the step only has to be completed 
once. 
 
Key: 
 

F = Filer 
 

RC = Rules Coordinator 
 

AH = Agency Head 
 

G = Governor’s Office 
 

DOS = Department of State 

 
 

6.2.1.1 Proposed Regular Rulemaking Process Steps  

Rulemaking Step F RC AH DOS 

Initial Data Entry and Documents Upload X X X  

DOS Verification of Drafts    X 

Generation of the Notice of Proposed Rulemaking* X X X  

Submission for Promulgation RICR automatic step 

Public Comment Period Begin RICR automatic step 

Post Public Comment Period Data update and Document 
Upload 

X X X 
 

DOS Final Regulation Approval    X 

Agency Head Signature Applied   X  

Final Rule and Signature Acceptance by DOS    X 

Promulgation Finalization  RICR automatic step 

 

*As soon as the user clicks Publish, the Proposed Rule is live (viewable) in the RICR. 

https://rules.sos.ri.gov/


 
 
 
 

 103 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6.2.1.2 Proposed Direct Final Rulemaking Process Steps 

Rulemaking Step F RC AH DOS 

Initial Data Entry and Documents Upload X X X  

DOS Verification of Drafts    X 

Generation of the Notice of Proposed Rulemaking* X X X  

Submission for Promulgation RICR automatic step 

Public Comment Period Begin RICR automatic step 

Post Public Comment Period Data update and Document 
Upload 

X X X 
 

DOS Final Regulation Approval    X 

Agency Head Signature Applied   X  

Final Rule and Signature Acceptance by DOS    X 

Promulgation Finalization  RICR automatic step 

 

*As soon as the user clicks Publish, the Proposed Rule is viewable in the RICR. 
 
 

6.2.1.3 Emergency Rulemaking Process Steps 

Rulemaking Step F RC AH G DOS 

Initial Data Entry and Documents Upload X X X   

Rules Coordinator Notification of Emergency Rule  X    

Submission for Promulgation RICR automatic step 

Agency Head Signature Applied   X   

Governor Signature Applied    X  

Final Rule and Signature Acceptance by DOS*     X 

Promulgation Finalization RICR automatic step 

Submission for Emergency Extension 1 X X X   

DOS Final Revision for Emergency Extension 1**     X 

Finalization of Emergency Extension 1 RICR automatic step 

 

*As soon as the DOS signs, the Rule is viewable in the RICR. 
 

**As soon as the DOS approves, the Expiration Date is extended in the RICR. 
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6.2.1.4 Advance Notice of Proposed Rulemaking Process Steps 

Rulemaking Step F RC AH DOS 

Initial Data Entry and Documents Upload X X X  

Generation of the Notice of Proposed Rulemaking* X X X  

Public Comment Period Begin RICR automatic step 

Initial Data Entry and Documents Upload X X X  

DOS Verification of Drafts    X 

Generation of the Notice of Proposed Rulemaking X X X  

Submission for Promulgation RICR automatic step 

Public Comment Period Begin RICR automatic step 

Post Public Comment Period Data update and Document 
Upload 

X X X 
 

DOS Final Regulation Approval    X 

Agency Head Signature Applied   X  

Final Rule and Signature Acceptance by DOS    X 

Promulgation Finalization  RICR automatic step 

 

*As soon as the user clicks Publish, the Proposed Rule is viewable in the RICR. 
 
 

6.2.1.5 APA Exempt Rulemaking Process Steps 

Rulemaking Step F RC AH DOS 

Initial Data Entry and Documents Upload X X X  

Rules Coordinator Approval for Notice of Proposed Rulemaking  X   

DOS Verification of Drafts    X 

Submission for Promulgation RICR automatic step 

Rules Coordinator Approval for Final Submission  X   

Agency Head Signature Applied   X  

Final Rule and Signature Acceptance by DOS*    X 

Promulgation Finalization RICR automatic step 

 

*As soon as the DOS signs, the Rule is viewable in the RICR. 
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6.2.1.6 Technical Revision Rulemaking Process Steps 

There are no Technical Revision rulemaking process steps required from agencies 
within the RICR System. See § 6.3.1.5 of this Guide for additional information. 
 
 

6.2.1.7 Periodic Refile Rulemaking Process Steps 

After the first step, the subsequent steps will not be visible in the RICR System until 
after the Refile has gone live in the RICR. 
 

Rulemaking Step F RC AH DOS 

Refile  X   

Initial Data Entry and Documents Upload    X 

Submission for Promulgation RICR automatic step 

Final Rule and Signature Acceptance by DOS    X 

Promulgation Finalization* RICR automatic step 

 

*The refile is viewable in the RICR on the first Tuesday in January. 
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6.2.2 Rulemaking Document Types 

The following rulemaking documents may be uploaded in the RICR Filing System to 
be included in the final Rulemaking Record (see R.I. Gen. Laws Chapter 42-35 for full 
requirements): 
 

Document Statutory Requirement RICR Requirement 

Proposed Rule R.I. Gen. Laws § 42-35-2.3(b)(4) Required 

Index of Studies/Reports R.I. Gen. Laws § 42-35-2.3(b)(3) Optional 

Internal Organization Document R.I. Gen. Laws § 42-35-2.3(b)(9) 
 

Optional 

Petition R.I. Gen. Laws § 42-35-2.3(b)(8) Optional 

Additional Documentation  Optional 

Studies/Reports R.I. Gen. Laws § 42-35-2.3(b)(3) Optional 

Notice of Proposed Rulemaking R.I. Gen. Laws § 42-35-2.7 Auto-generated by 
the RICR System* 

Concise Explanatory Statement R.I. Gen. Laws § 42-35-2.6 Required 

Final Rule R.I. Gen. Laws § 42-35-4 Required 

Public Comment R.I. Gen. Laws § 42-35-2.3(b)(6) Required 

Public Hearing Documents R.I. Gen. Laws § 42-35-2.3(b)(5) Optional 

State Register Publication R.I. Gen. Laws § 42-35-2.3(b)(1) Optional 

 
*After user enters required information and clicks Generate. 
 
 
 
 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/INDEX.HTM
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.6.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.3.htm
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6.2.2.1 Permitted File Types 

To ensure files are able to upload into the RICR Filing System, use the following to 
identify what file type the associated document should be saved as: 
 

Process Document Type File Type(s) Permitted 

Proposed 
Rulemaking 

Proposed Rule .docx 

Index of Studies/Reports .doc, .docx, .pdf, .xlsx 

Internal Organization 
Document 

.doc, .docx, .pdf, .xlsx 

Petition .doc, .docx, .pdf, .xlsx 

Additional Documentation 
.doc, .docx, .pdf, .xlsx, .jpg, 
.jpeg 

Studies/Reports .doc, .docx, .pdf, .xlsx 

Final 
Rulemaking 

Concise Explanatory Statement .doc, .docx, .pdf, .xlsx 

Final Rule .docx 

Public Comment .doc, .docx, .pdf, .xlsx 

Index of Studies/Reports .doc, .docx, .pdf, .xlsx 

Internal Organization 
Document 

.doc, .docx, .pdf, .xlsx 

Petition .doc, .docx, .pdf, .xlsx 

Public Hearing Documents .doc, .docx, .pdf, .xlsx 

Additional Documentation 
.doc, .docx, .pdf, .xlsx, .jpg, 
.jpeg 

State Register publication .doc, .docx, .pdf, .xlsx 

Studies/Reports .doc, .docx, .pdf, .xlsx 
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6.2.3 RICR Rulemaking Process Icons 

6.2.3.1 RICR Process Steps Icon Key 

In § 6.3 of this Guide, look for the following icons to identify what step in the 
process you are at in this Guide, based on the steps in § 6.2.1 of this Guide: 
 

Icon Identification Meaning 

 
Indicates a step in the process to be completed. 

 
Indicates when the step is completed. 

 
Indicates what needs to occur before taking the next step. 

 
 

6.2.3.1 RICR Current Rules Tab Icon Key 

In the RICR Current Rules tab, use the following clickable icons to navigate: 
 

Icon Navigation Meaning 

 
Promulgate New APA-Compliant Adoption 

 
Promulgate New APA-Exempt Adoption 
For exempt agencies only, per R.I. Gen. Laws § 42-35-18. 

 
Promulgate New Amendment 

 
Promulgate New Repeal 

 
Download Currently Active Rule Document 

 
Renew Emergency Rule by 60 Days 

 
Terminate Emergency Rule 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
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6.2.3.1 RICR Work Queue Tab Icon Key 

In the RICR Work Queue tab, use the following clickable icons to navigate: 
 

Icon Navigation Meaning 

 
Advance Workflow to Next Step 

 
Start Rulemaking for Advance Notice Rule 

 
Terminate Rule 

 
Upload Rule & Associated Documents 

 
Generate Notice of Proposed Rulemaking 

 
Edit Rulemaking Filing Details 

 
Review Public Comments 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

 110 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6.2.4 Terminating Rules 

At multiple stages of the promulgation process (noted for each eligible stage in § 6.3 
of this Guide), agencies have the option to terminate, which will discontinue the rule 
before it goes into effect. 
 
If the rule has already started its Public Comment Period: 
 

1. Anyone who receives Regulation Notifications (§ 2.7 of this Guide), including 
the public and other agencies, will receive notice of the termination; and 
 

2. If an adoption was terminated, the Part number cannot be reused in the future 
due to how the RICR System tracks rulemaking, and the next sequential Part 
number must be used if starting over. 

 
If the rule has not yet started its Public Comment Period: 
 

1. No notification will be sent; and 
 

2. If an adoption was terminated, the Part number can be reused in the future. 
 
When terminating a rule, a reason for the termination is required for internal 
purposes only. The reason will not be published and will never be seen by the public. 
 

 
 

Once a rule has been terminated, this action cannot be reversed. 
 

If a rule still needs to be promulgated, the rulemaking process must start over. 
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6.2.5 Identifying the Promulgation ID 

All rules promulgated in the RICR Filing System are assigned a Promulgation ID. 
 

Always provide the Promulgation ID when communicating with the Administrative 
Records Office to ensure the correct rule is investigated if an issue arises. 
 
To identify the Promulgation ID in the RICR Filing System: 
 

1. When a rule is open (in any tab), look at the website URL in the browser. 
 

2. The Promulgation ID is the five (5) numbers following id=#####. 

 

For example: 
 

https://rules.sos.ri.gov/Dashboard/Landing?id=13121&act=p 
 

The Promulgation ID is 13121. 

 
To identify the Promulgation ID in the RICR: 
 

1. When a Part is open to the Regulation tab in the RICR, click Download 
Regulation to open the PDF: 

 

 
 

2. Look at the website URL of the PDF in the browser. 
 

3. The Promulgation ID is the five (5) numbers following REG_#####. 
 

For example: 
 

https://risos-apa-production-
public.s3.amazonaws.com/SOS/REG_13122_20240424154529664.pdf 
 

The Promulgation ID is 13122. 
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6.3 Step-By-Step Filing Instructions 

6.3.1 Rules Coordinator Instructions 

6.3.1.1 Adoptions 

6.3.1.1.1 Proposed Regular Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.1 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.1.1.1 Initial Data Entry and Documents Upload 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, and Subchapter to 
open each level, then click New Adoption to promulgate a new rule: 
 

 

https://rules.sos.ri.gov/
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3. Enter in the Rulemaking Filing Details: 
 

 
 

a. Choose Proposed, then Regular, for the Rulemaking Action and 
Rulemaking Process; 
 

 
 

b. Enter the Rule Identifier (a.k.a. Part number); 
 

i. Part numbers may only be used once (§ 2.3.4 of this 
Guide). The RICR System will display an error message if a 
Part number has already been used after clicking the next 
field: 
 

 
 

ii. Enter in a new Part number until you no longer see an 
error, then update rulemaking documents to use the new 
Part number. 
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c. Enter the Regulation Title using sentence case (i.e., use “Conduct 
of Public Hearings”, not “CONDUCT OF PUBLIC HEARINGS”); and 
 

d. Choose the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. If citing a whole R.I. General Law Title or Chapter, select 
“Alternative” and write the citation in full. Selecting “R.I. 
General Laws” automatically adds a section symbol (§). 
 

ii. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

4. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

5. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

8. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 

9. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 



 
 
 
 

 117 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

10. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 9-10 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

11. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

12. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 14(b)(i): 
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13. To continue, click the Advance Workflow icon: 
 

 
 

14. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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15. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 13 to proceed. 

 
16. If you would like to add a note for the DOS, enter text in the Request 

Note and/or click Submit: 
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17. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 

 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.1.1.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.1.1.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 

https://rules.sos.ri.gov/
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4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
 

 
 

5. Fill out the form to add a Public Comment Period – all fields are 
required: 
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a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 

 
6. If there will be a hearing, click on the Public Comment Period, then click 

Add >> under Add a Public Hearing: 
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7. Fill out the form to add a Public Hearing – all fields are required: 
 

 
 

8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
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9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
 

10. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 
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  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/organizations
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6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
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8. The Overview tab displays the rule details: 
 

 
 
 

6.3.1.1.1.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.1.1.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
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6.3.1.1.1.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
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c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
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4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 

 
ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
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c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
 

6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
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8. To continue, click the Advance Workflow icon: 
 

 
 

9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

10. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 8 to proceed. 
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11. If you would like to add a note for the DOS (i.e., if you would like the rule 
to become effective on a future date other than the minimum 20-day 
waiting period), enter text in the Request Note and/or click Submit: 
 

 
 

12. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 

 
 
 

6.3.1.1.1.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
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indicate the rule is ready to be signed by the Agency Head: 
 

 
 
 

6.3.1.1.1.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.1.1.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
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6.3.1.1.1.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.1.2 Proposed Direct Final Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.2 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.1.2.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, and Subchapter to 
open each level, then click New Adoption to promulgate a new rule: 
 

 
 
 
 

https://rules.sos.ri.gov/
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3. Enter in the Rulemaking Filing Details: 
 

 
 

a. Choose Proposed, then Direct Final, for the Rulemaking Action 
and Rulemaking Process; 
 

 
 

b. Enter the Rule Identifier (a.k.a. Part number); 
 

i. Part numbers may only be used once (§ 2.3.4 of this 
Guide). The RICR System will display an error message if a 
Part number has already been used after clicking the next 
field: 
 

 
 

ii. Enter in a new Part number until you no longer see an 
error, then update rulemaking documents to use the new 
Part number. 
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c. Enter the Regulation Title using sentence case (i.e., use “Conduct 
of Public Hearings”, not “CONDUCT OF PUBLIC HEARINGS”); and 
 

d. Choose the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. If citing a whole Title or Chapter in the R.I. General Laws, 
select “Alternative” and write the citation in full. Selecting 
“R.I. General Laws” automatically adds a section symbol (§). 
 

ii. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

4. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

5. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

8. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm


 
 
 
 

 143 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 

9. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
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b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

10. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 9-10 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

11. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

12. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 14(b)(i): 
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13. To continue, click the Advance Workflow icon: 
 

 
 

14. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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15. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 13 to proceed. 

 
16. If you would like to add a note for the DOS, enter text in the Request 

Note and/or click Submit: 
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17. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.1.2.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.1.2.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 
 

https://rules.sos.ri.gov/
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4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
 

 
 

5. Fill out the form to add a Public Comment Period – all fields are 
required: 
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a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 

 
6. Click Generate Notice (this will not publish the rule, only preview the 

notice): 
 

 
 

7. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
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back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
 

8. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 

 

 
 
 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 

https://rules.sos.ri.gov/organizations
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3. Click the plus sign (+) next to the Title: 
 

 
 

4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
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7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
 

 
 

8. The Overview tab displays the rule details: 
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6.3.1.1.2.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.1.2.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
 
 

6.3.1.1.2.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 

i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 
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b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
 

 
 

c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
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e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
 

 
 

4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 
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ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
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6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
 

 
 

8. To continue, click the Advance Workflow icon: 
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9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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10. If you would like to add a note for the DOS (i.e., if you would like the rule 
to become effective on a future date rather than the last day of the 
Public Comment Period), enter text in the Request Note and/or click 
Submit: 
 

 
 

11. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 
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6.3.1.1.2.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
indicate the rule is ready to be signed by the Agency Head: 
 

 
 

6.3.1.1.2.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.1.2.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
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6.3.1.1.2.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.1.3 Emergency Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.3 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Notification of Emergency Rule Rules Coordinator 

Submission for Promulgation RICR Filing System 

Agency Head Signature Applied Agency Head 

Governor Signature Applied Governor 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

Submission for Emergency Extension 1 Rules Coordinator 

DOS Final Revision for Emergency Extension 1 Department of State 

Finalization of Emergency Extension 1 RICR Filing System 

 
 

6.3.1.1.3.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, and Subchapter to 
open each level, then click New Adoption to promulgate a new rule: 
 

 
 
 
 
 

https://rules.sos.ri.gov/
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3. Enter in the Rulemaking Filing Details: 
 

 
 

a. Choose Emergency for the Rulemaking Action; 
 

 
 

b. Enter the Rule Identifier (a.k.a. Part number); 
 

i. Part numbers may only be used once (§ 2.3.4 of this 
Guide). The RICR System will display an error message if a 
Part number has already been used after clicking the next 
field: 
 

 
 

ii. Enter in a new Part number until you no longer see an 
error, then update rulemaking documents to use the new 
Part number. 
 

c. Enter the Regulation Title using sentence case (i.e., use “Conduct 
of Public Hearings”, not “CONDUCT OF PUBLIC HEARINGS”); and 
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d. Choose the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

4. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

5. Enter the Brief Statement of Reason for Finding Imminent Peril to state 
the reason this rule is required in order to avoid a threat to public 
health, safety, or welfare, or the loss of federal funding for an agency 
program (R.I. Gen. Laws § 42-35-2.10): 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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6. Enter the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

8. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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9. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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10. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 9-10 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

11. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Brief Statement of Reason for Finding Imminent 
Peril, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
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13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 15(b)(i): 
 

 
 

14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
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b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

16. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 14 to proceed. 
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17. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.1.3.2 Rules Coordinator Notification of 
Emergency Rule 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined that the rule should not 

move forward, click the Terminate icon to end the promulgation process 
and skip to step 3(b)(i): 
 

 
 

2. To continue, click the Advance Workflow icon: 
 

 
 

3. To advance the rule for the DOS Formatting Review, click Advance: 
 

 



 
 
 
 

 174 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Notification of Emergency Rule 

 
 

6.3.1.1.3.3 Submission for Promulgation 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically advance the rule to the next step. 
 
 

6.3.1.1.3.4 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.1.3.5 Governor Signature Applied 

This step will be completed by the Agency Head. 
 
The Governor will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
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6.3.1.1.3.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head and Governor signs the rule, the Department of 
State will sign the rule and set the rule’s Effective Date. 
 
 

6.3.1.1.3.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 
 
 

6.3.1.1.3.8 Submission for Emergency Extension 1 

 

If the Emergency Rule must be extended: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the 60-Day Emergency Renewal icon 
(calendar) next to the Part to be extended: 
 

 
 
 
 
 
 

https://rules.sos.ri.gov/
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3. To confirm the Part should be extended, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the Emergency Rule immediately, which 
will change the rule’s Expiration Date to be set as today’s date: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.1.3.9 DOS Final Revision for Emergency 
Extension 1 

This step will be completed by the Administrative Records Office. 
 
The Department of State will confirm the extension and advance the rule. 
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6.3.1.1.3.10 Finalization of Emergency Extension 1 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically extend the Expiration Date for the 
Emergency Regulation in the RICR. 
 
 

6.3.1.1.3.11 Early Termination 

 

If the Emergency Rule must be terminated before the set Expiration Date: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the Terminate icon next to the Part to be 
terminated: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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3. Select a Termination Reason, then click Submit to terminate, or click 
Cancel: 

 

 
 

4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

6.3.1.1.3.11.1 Finalization of Termination 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically change the Expiration Date for the 
Emergency Regulation in the RICR to today’s date. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
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RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/Organizations
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6.3.1.1.4 Advance Notice of Proposed Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.4 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Public Comment Period Begin 
RICR Filing System & 
Rules Coordinator 

 
 

6.3.1.1.4.1 Initial Data Entry and Documents Upload 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, and Subchapter to 
open each level, then click New Adoption to promulgate a new rule: 
 

 
 

3. Enter in the Rulemaking Filing Details: 
 

 

https://rules.sos.ri.gov/
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a. Choose Proposed, then Regular, for the Rulemaking Action and 
Rulemaking Process; 
 

 
 

b. Enter the Rule Identifier (a.k.a. Part number); 
 

i. Part numbers may only be used once (§ 2.3.4 of this 
Guide). The RICR System will display an error message if a 
Part number has already been used after clicking the next 
field: 
 

 
 

ii. Enter in a new Part number until you no longer see an 
error, then update rulemaking documents to use the new 
Part number. 
 

c. Enter the Regulation Title using sentence case (i.e., use “Conduct 
of Public Hearings”, not “CONDUCT OF PUBLIC HEARINGS”); and 
 

d. Choose the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

4. Enter the Advance Notice Details to indicate where, when, and how 
persons may comment before the rulemaking process begins (any 
meeting held is open to the Open Meetings Act and subject to R.I. Gen. 
Laws Chapter 42-46): 

https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

5. Enter the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

6. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

7. DO NOT CLICK ANYTHING UNTIL ALL OPTIONS ARE REVIEWED 
There are three (3) options to move forward based on if documents 
need to be uploaded or not, and two (2) options have immediate 
ramifications.  
 
Advance Notice Rulemaking does not require documents to be 
uploaded, however, if the promulgating agency wants or needs to 
upload documents, the following optional documents may be 
uploaded: 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule must 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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also be uploaded to be able to advance to the next step. 
 
Read through all three options carefully before determining and taking 
action to advance to the next step: 
 

a. Advance Workflow – Choose if you don’t need to upload 
documents. 
If you choose this option, documents may still be uploaded later if need 
be. 
 

See step 8 for next steps. 
 

b. Upload Documents – Choose if you need to upload documents. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

See step 9 for next steps. 
 

c. Home – Equivalent to choosing Upload Documents, do not use. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

If accidentally clicked, see step 10 for next steps. 
 

 
 

8. For Advance Workflow: 
 

a. Click Advance Workflow: 
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b. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 11: 
 

  
 

i. If for any reason at this stage it is determined that 
documents need to be uploaded, click Cancel and skip to 
step 10(b); or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

  
 

9. For Upload Documents: 
 

a. Click Upload Documents: 
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b. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

c. Click Choose File to select the document from your computer. 
 

d. Click Upload Document to upload. 
 

e. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps b-e for each additional document 
(you will not be able to advance the rule until the Proposed Rule is 
uploaded), or click Home: 
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f. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 9(h)(ii)(1): 
 

  
 

g. To continue, click the Advance Workflow icon: 
 

  
 

h. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 11: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
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(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

 
 

10. DO NOT USE – ONLY FOLLOW IF ACCIDENTALLY CHOSEN 
 

For Home: 
 

a. Click Home: 
 

 
 

b. Click the Upload Documents icon next to the Part in the Work 
Queue tab to upload documents to be able to advance the rule: 
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c. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

d. Click Choose File to select the document from your computer. 
 

e. Click Upload Document to upload. 
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f. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps c-f for each additional document, or 
click Home: 

 

 
 

g. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 10(i)(ii)(1): 
 

 
 

h. To continue, click the Advance Workflow icon: 
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i. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 11: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
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11. Certify that your agency will receive official approval from OMB if the 
rule is to be fully promulgated or is exempt from OMB’s review process 
by clicking Yes: 
 

 
 

12. If you would like to add a note for the DOS for the future DOS review, 
enter text in the Request Note and/or click Submit: 
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13. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.1.4.2 Generation of the Notice of Proposed 
Rulemaking 

 

1. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level to view the rule. 

 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, and 
Advance Notice Details, then click Submit once the details are updated:  
 

Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 



 
 
 
 

 195 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

3. Click the Generate/Review Docs icon: 
 

 
 

4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
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5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 
 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 

 
 



 
 
 
 

 197 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6. If there will be a hearing, click on the Public Comment Period, then click 
Add >> under Add a Public Hearing: 
 

 
 

7. Fill out the form to add a Public Hearing – all fields are required: 
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8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 

9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
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10. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 

 

  
 

 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 

https://rules.sos.ri.gov/organizations
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4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

 201 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
 

 
 

8. The Overview tab displays the rule details: 
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6.3.1.1.4.3 Public Comment Period Begin 

The first half of this step will be completed automatically by the RICR 
System to start the Public Comment Period in the RICR. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.1.4.4 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
 
 

6.3.1.1.4.4 Public Comment Period Begin 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
 

 
 
 
 
 



 
 
 
 

 204 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. To start rulemaking, in the Work Queue tab, click on the Title, Chapter, 
and Subchapter to open each level, then click the Start Rulemaking 
icon: 
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a. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process: 
 

 
 

b. Select a Termination Reason, then click Submit to terminate. 
 
DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 
RULEMAKING.  
 
Instead, click the RICR logo at the top-left corner to go back if 
need be. 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

a. Choose the Rulemaking Action and Rulemaking Process to start 
rulemaking, either Proposed Regular, Proposed Direct Final, or 
Emergency: 
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If another Advance Notice Public Comment Period is necessary, 
choose Advance Notice. 
 

 
 

b. Confirm the Regulation Title is correct and uses sentence case 
(i.e., use “Conduct of Public Hearings”, not “CONDUCT OF 
PUBLIC HEARINGS”); and 
 

c. Confirm the Rulemaking Authority is correct and update as 
necessary by selecting the appropriate authority from the 
dropdown, enter the Rulemaking Authority citation, and click 
Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 

 

 
 

d. If Proposed Regular or Proposed Direct Final was chosen: 
 

i. Enter the Summary of Proposed Rule in plain language of 
terms or substance of intended action, or description of 
the subjects and issues involved, including changes 
between current and proposed regulations: 
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1. If copying text from another document, follow the 
directions on screen to strip all erroneous 
formatting. 

 

 
 

ii. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal 
cost and benefits of compliance as prepared under R.I. 
Gen. Laws § 42-35-2.9, including any citations to scientific 
or statistical studies, reports, and analyses that served as a 
basis for the proposed rule: 
 

1. If copying text from another document, follow the 
directions on screen to strip all erroneous 
formatting. 

 

 
 

e. If Emergency was chosen: 
 

i. Enter the Brief Statement of Reason for Finding Imminent 
Peril to state the reason this rule is required in order to 
avoid a threat to public health, safety, or welfare, or the 
loss of federal funding for an agency program (R.I. Gen. 
Laws § 42-35-2.10): 
 
 
 
 
 
 

https://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
https://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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1. If copying text from another document, follow the 
directions on screen to strip all erroneous 
formatting. 

 

 
 

f. If Advance Notice was chosen: 
 

i. Enter the Advance Notice Details to indicate where, when, 
and how persons may comment before the rulemaking 
process begins (any meeting held is open to the Open 
Meetings Act and subject to R.I. Gen. Laws Chapter 42-46): 
 

1. If copying text from another document, follow the 
directions on screen to strip all erroneous 
formatting. 

 

 
 

5. Confirm the Additional Information URL is correct to indicate the 
location on your website where the Notice of Proposed Rulemaking is 
published as required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

6. Review to ensure all entered text is correct and click Submit. 
 
DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 

https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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RULEMAKING.  
 
Instead, click the RICR logo at the top-left corner to go back if need be. 
 
 

 
  COMPLETED: Public Comment Period Begin 

 
 

6.3.1.1.4.5 Initial Data Entry and Documents Upload 

 

1. Based on the Rulemaking Action and Process chosen, continue 
rulemaking by following: 
 

a. Proposed Regular Rulemaking in § 6.3.1.1.1.1(9) of this Guide; 
 

b. Proposed Direct Final Rulemaking in § 6.3.1.1.2.1(9) of this 
Guide; 
 

c. Emergency Rulemaking in § 6.3.1.1.3.1(9) of this Guide; or 
 

d. Restart Advance Notice Rulemaking in § 6.3.1.1.4.1(7) of this 
Guide. 
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6.3.1.1.5 APA Exempted Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.5 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Approval for Notice of Proposed Rulemaking Rules Coordinator 

DOS Verification of Drafts Department of State 

Submission for Promulgation RICR Filing System 

Rules Coordinator Approval for Final Submission Rules Coordinator 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
Before initiating the process in the RICR Filing System, email the 
Administrative Records Office (ARO) to request the APA Exemption be applied 
to the Part to be promulgated: 
 

1. Provide the full RICR Citation (##-RICR-##-##-#); and 
 

2. Confirm the promulgating agency/division may use the exemption per 
R.I. Gen. Laws § 42-35-18. 

 
Only once the ARO confirms in an email reply that the exemption was applied 
can the promulgation process be started in the RICR Filing System. 
 
 

6.3.1.1.5.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, and Subchapter to 
open each level, and: 
 

a. Ensure the New Adoption button is green, not blue; and 
 

If the button is blue, do not move forward with the promulgation 
and immediately contact the ARO per § 6.3.1.1.5 of this Guide. 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
https://rules.sos.ri.gov/
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b. Click New Adoption to promulgate a new rule: 
 

 
 

3. Enter in the Rulemaking Filing Details: 
 

 
 

a. Do not choose a Rulemaking Action; 
 

b. Enter the Rule Identifier (a.k.a. Part number) as confirmed in the 
email exchange with the ARO.  
 
After clicking the next field to fill out, this should immediately 
update the Rulemaking Action to display APA Exempted: 
 

 
 

If the Rulemaking Action does not change to APA Exempted, do 
not move forward with the promulgation and instead scroll to the 
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bottom of the page to click Cancel and email the ARO 
immediately to fix this; 
 

i. Part numbers may only be used once (§ 2.3.4 of this 
Guide). The RICR System will display an error message if a 
Part number has already been used after clicking the next 
field: 
 

 
 

ii. Enter in a new Part number until you no longer see an 
error, then update rulemaking documents and work with 
the ARO to apply the exemption to use the new Part 
number. 
 

c. Enter the Regulation Title using sentence case (i.e., use “Conduct 
of Public Hearings”, not “CONDUCT OF PUBLIC HEARINGS”); and 
 

d. Choose the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

4. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 
 
 
 
 
 

mailto:rulesregs@sos.ri.gov
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

5. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm


 
 
 
 

 214 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

used. 
 

8. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 

9. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule (actually the Final Rule, 2 versions)* 
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ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

* There will be no option to upload a “Final Rule”. 
Upload the Final Rule as the Proposed Rule document type. 

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
 

10. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 9-10 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
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11. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 

Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 15(b)(i): 
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14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

16. Enter what the Effective Date should be set to (i.e., either a minimum 20-
day waiting period or other date) in the Request Note and click Submit: 
 

 
 

17. Upon submitting, click OK to return to the RICR System homepage: 
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COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.1.5.2 Rules Coordinator Approval for Notice of 
Proposed Rulemaking 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined the filing details needs 

updating or additional documents need to be uploaded, click on the 
Edit Filing icon (paper with pencil) or the Upload Documents icon 
(paper with blue arrow): 
 

 
 

2. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 4(b)(i): 
 

 
 
 
 
 
 
 
 



 
 
 
 

 220 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

3. To continue, click the Advance Workflow icon: 
 

 
 

4. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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5. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

6. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Rules Coordinator Approval for Notice of Proposed 
Rulemaking 
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6.3.1.1.5.3 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.1.5.4 Rules Coordinator Approval for Final 
Submission 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance once the Administrative Records Office has completed their 
formatting review. 
 
1. To advance the rule for final signatures or to terminate the rule, click the 

Advance Workflow icon: 
 

 
 

2. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

3. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Approval for Final Submission 

 
 

6.3.1.1.5.5 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
Once the Rules Coordinator advances the rule, the Agency Head will 
receive an automated email from OneSpan, the esignature provider, to sign 
the rule. 
 
 

6.3.1.1.5.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
 
 

6.3.1.1.5.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
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Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.2 Amendments 

6.3.1.2.1 Proposed Regular Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.1 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.2.1.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
amendment (see § 5.1.2.2 of this Guide for additional information): 
 

 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Amendment icon promulgate an amendment: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Proposed, then Regular, for the Rulemaking Action and 
Rulemaking Process; 
 

 
 

b. Confirm the Regulation Title using sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 



 
 
 
 

 229 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 
 
 
 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm


 
 
 
 

 231 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 

10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
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b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 9-10 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 14(b)(i): 
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14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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16. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 13 to proceed. 

 
17. If you would like to add a note for the DOS, enter text in the Request 

Note and/or click Submit: 
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18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 

 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.2.1.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.2.1.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 
 
 

https://rules.sos.ri.gov/
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4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
 

 
 

5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 



 
 
 
 

 238 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 

 
6. If there will be a hearing, click on the Public Comment Period, then click 

Add >> under Add a Public Hearing: 
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7. Fill out the form to add a Public Hearing – all fields are required: 
 

 
 

8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 
 
 
 
 
 
 
 



 
 
 
 

 240 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
 

10. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 
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  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/organizations
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6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
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8. The Overview tab displays the rule details: 
 

 
 
 

6.3.1.2.1.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.2.1.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
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6.3.1.2.1.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
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c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
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4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 

 
ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
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c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
 

6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
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8. To continue, click the Advance Workflow icon: 
 

 
 

9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

10. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 8 to proceed. 

 
11. If you would like to add a note for the DOS (i.e., if you would like the rule 

to become effective on a future date other than the minimum 20-day 
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waiting period), enter text in the Request Note and/or click Submit: 
 

 
 

12. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 
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6.3.1.2.1.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
indicate the rule is ready to be signed by the Agency Head: 
 

 
 
 

6.3.1.2.1.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.2.1.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
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Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
 
 

6.3.1.2.1.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.2.2 Proposed Direct Final Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.2 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.2.2.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
amendment (see § 5.1.2.2 of this Guide for additional information): 
 

 
 
 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Amendment icon promulgate an amendment: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Proposed, then Direct Final, for the Rulemaking Action 
and Rulemaking Process; 
 

 
 

b. Confirm the Regulation Title using sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
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i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm


 
 
 
 

 258 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 15(b)(i): 
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14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

16. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 14 to proceed. 
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17. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.2.2.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
 

 
 
 

6.3.1.2.2.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
 
 

https://rules.sos.ri.gov/
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Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 

4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
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5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 
 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 
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6. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 

7. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
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8. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 

 

 
 
 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

https://rules.sos.ri.gov/organizations
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4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

 269 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
 

 
 

8. The Overview tab displays the rule details: 
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6.3.1.2.2.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.2.2.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
 
 

6.3.1.2.2.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 

i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 
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b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
 

 
 

c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
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e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
 

 
 

4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 
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ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
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6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
 

 
 

8. To continue, click the Advance Workflow icon: 
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9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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10. If you would like to add a note for the DOS (i.e., if you would like the rule 
to become effective on a future date rather than the last day of the 
Public Comment Period), enter text in the Request Note and/or click 
Submit: 
 

 
 

11. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 
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6.3.1.2.2.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
indicate the rule is ready to be signed by the Agency Head: 
 

 
 
 

6.3.1.2.2.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.2.2.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
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rule and set the rule’s Effective Date. 
 
 

6.3.1.2.2.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.2.3 Emergency Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.3 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Notification of Emergency Rule Rules Coordinator 

Submission for Promulgation RICR Filing System 

Agency Head Signature Applied Agency Head 

Governor Signature Applied Governor 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

Submission for Emergency Extension 1 Rules Coordinator 

DOS Final Revision for Emergency Extension 1 Department of State 

Finalization of Emergency Extension 1 RICR Filing System 

 
 

6.3.1.2.3.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
amendment (see § 5.1.2.2 of this Guide for additional information): 
 

 
 
 
 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Amendment icon promulgate an amendment: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Emergency for the Rulemaking Action; 
 

 
 

b. Confirm the Regulation Title using sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
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i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Brief Statement of Reason for Finding Imminent Peril to state 
the reason this rule is required in order to avoid a threat to public 
health, safety, or welfare, or the loss of federal funding for an agency 
program (R.I. Gen. Laws § 42-35-2.10): 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Brief Statement of Reason for Finding Imminent 
Peril, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

13. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
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14. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 16(b)(i): 
 

 
 

15. To continue, click the Advance Workflow icon: 
 

 
 

16. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

17. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 15 to proceed. 
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18. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

19. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.2.3.2 Rules Coordinator Notification of 
Emergency Rule 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined that the rule should not 

move forward, click the Terminate icon to end the promulgation process 
and skip to step 3(b)(i): 
 

 
 

2. To continue, click the Advance Workflow icon: 
 

 
 

3. To advance the rule for the DOS Formatting Review, click Advance: 
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a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Notification of Emergency Rule 

 
 

6.3.1.2.3.3 Submission for Promulgation 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically advance the rule to the next step. 
 
 

6.3.1.2.3.4 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.2.3.5 Governor Signature Applied 

This step will be completed by the Agency Head. 
 
The Governor will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
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6.3.1.2.3.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head and Governor signs the rule, the Department of 
State will sign the rule and set the rule’s Effective Date. 
 
 

6.3.1.2.3.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 
 
 

6.3.1.2.3.8 Submission for Emergency Extension 1 

 

If the Emergency Rule must be extended: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the 60-Day Emergency Renewal icon 
(calendar) next to the Part to be extended: 
 

 
 
 
 
 

https://rules.sos.ri.gov/
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3. To confirm the Part should be extended, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the Emergency Rule immediately, which 
will change the rule’s Expiration Date to be set as today’s date: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
 

 
 
 
 
 
 
 
 



 
 
 
 

 294 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.2.3.9 DOS Final Revision for Emergency 
Extension 1 

This step will be completed by the Administrative Records Office. 
 
The Department of State will confirm the extension and advance the rule. 
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6.3.1.2.3.10 Finalization of Emergency Extension 1 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically extend the Expiration Date for the 
Emergency Regulation in the RICR. 
 
 

6.3.1.2.3.11 Early Termination 

 

If the Emergency Rule must be terminated before the set Expiration Date: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the Terminate icon next to the Part to be 
terminated: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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3. Select a Termination Reason, then click Submit to terminate, or click 
Cancel: 

 

 
 

4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

6.3.1.2.3.11.1 Finalization of Termination 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically change the Expiration Date for the 
Emergency Regulation in the RICR to today’s date. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.2.4 Advance Notice of Proposed Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.4 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Public Comment Period Begin 
RICR Filing System & 
Rules Coordinator 

 
 

6.3.1.2.4.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
amendment (see § 5.1.2.2 of this Guide for additional information): 
 

 
 

3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Amendment icon promulgate an amendment: 
 

 

https://rules.sos.ri.gov/
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4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Advance Notice for the Rulemaking Action and 
Rulemaking Process; 
 

 
 

b. Confirm the Regulation Title using sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Advance Notice Details to indicate where, when, and how 
persons may comment before the rulemaking process begins (any 
meeting held is open to the Open Meetings Act and subject to R.I. Gen. 
Laws Chapter 42-46): 

https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
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a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

8. DO NOT CLICK ANYTHING UNTIL ALL OPTIONS ARE REVIEWED 
There are three (3) options to move forward based on if documents 
need to be uploaded or not, and two (2) options have immediate 
ramifications.  
 

Advance Notice Rulemaking does not require documents to be 
uploaded, however, if the promulgating agency wants or needs to 
upload documents, the following optional documents may be 
uploaded: 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule must 
also be uploaded to be able to advance to the next step. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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Read through all three options carefully before determining and taking 
action to advance to the next step: 
 

a. Advance Workflow – Choose if you don’t need to upload 
documents. 
If you choose this option, documents may still be uploaded later if need 
be. 
 

See step 9 for next steps. 
 

b. Upload Documents – Choose if you need to upload documents. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

See step 10 for next steps. 
 

c. Home – Equivalent to choosing Upload Documents, do not use. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

If accidentally clicked, see step 11 for next steps. 
 

 
 

9. For Advance Workflow: 
 

a. Click Advance Workflow: 
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b. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

  
 

i. If for any reason at this stage it is determined that 
documents need to be uploaded, click Cancel and skip to 
step 11(b); or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

  
 

10. For Upload Documents: 
 

a. Click Upload Documents: 
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b. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

c. Click Choose File to select the document from your computer. 
 

d. Click Upload Document to upload. 
 

e. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps b-e for each additional document 
(you will not be able to advance the rule until the Proposed Rule is 
uploaded), or click Home: 
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f. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 10(h)(ii)(1): 
 

  
 

g. To continue, click the Advance Workflow icon: 
 

  
 

h. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
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(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

 
 

11. DO NOT USE – ONLY FOLLOW IF ACCIDENTALLY CHOSEN 
 

For Home: 
 

a. Click Home: 
 

 
 

b. Click the Upload Documents icon next to the Part in the Work 
Queue tab to upload documents to be able to advance the rule: 
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c. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

d. Click Choose File to select the document from your computer. 
 

e. Click Upload Document to upload. 
 

f. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps c-f for each additional document 
(you will not be able to advance the rule until the Proposed Rule is 
uploaded), or click Home: 
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g. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 11(i)(ii)(1): 
 

 
 

h. To continue, click the Advance Workflow icon: 
 

 
 

i. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
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(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

 
 

12. Certify that your agency will receive official approval from OMB if the 
rule is to be fully promulgated or is exempt from OMB’s review process 
by clicking Yes: 
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13. If you would like to add a note for the DOS for the future DOS review, 
enter text in the Request Note and/or click Submit: 
 

 
 

14. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.2.4.2 Generation of the Notice of Proposed 
Rulemaking 

 

1. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level to view the rule. 

 
2. If for any reason the rule details need to be updated, click the Edit Filing 

icon to update the Regulation Title, Rulemaking Authority, and 
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Advance Notice Details, then click Submit once the details are updated:  
 

Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 

 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. Click the Generate/Review Docs icon: 
 

 
 

4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
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5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 
 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 
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6. If there will be a hearing, click on the Public Comment Period, then click 
Add >> under Add a Public Hearing: 
 

 
 

7. Fill out the form to add a Public Hearing – all fields are required: 
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8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 

9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
 

10. Click Home to return to the RICR home page: 
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a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 
 

 
 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

4. Click Agency Info: 
 

 

https://rules.sos.ri.gov/organizations
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5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
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8. The Overview tab displays the rule details: 
 

 
 
 

6.3.1.2.4.3 Public Comment Period Begin 

The first half of this step will be completed automatically by the RICR 
System to start the Public Comment Period in the RICR. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.2.4.4 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
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6.3.1.2.4.4 Public Comment Period Begin 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
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c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. To start rulemaking, in the Work Queue tab, click on the Title, Chapter, 
and Subchapter to open each level, then click the Start Rulemaking 
icon: 
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a. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process: 
 

 
 

b. Select a Termination Reason, then click Submit to terminate. 
 

DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 
RULEMAKING.  
 

Instead, click the RICR logo at the top-left corner to go back if 
need be. 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

a. Choose the Rulemaking Action and Rulemaking Process to start 
rulemaking, either Proposed Regular, Proposed Direct Final, or 
Emergency: 
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If another Advance Notice Public Comment Period is necessary, 
choose Advance Notice. 
 

 
 

b. Confirm the Regulation Title is correct and uses sentence case 
(i.e., use “Conduct of Public Hearings”, not “CONDUCT OF 
PUBLIC HEARINGS”); and 
 

c. Confirm the Rulemaking Authority is correct and update as 
necessary by selecting the appropriate authority from the 
dropdown, enter the Rulemaking Authority citation, and click 
Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 

 

 
 

d. If Proposed Regular or Proposed Direct Final was chosen: 
 

i. Enter the Summary of Proposed Rule in plain language of 
terms or substance of intended action, or description of 
the subjects and issues involved, including changes 
between current and proposed regulations: 

 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 
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ii. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal 
cost and benefits of compliance as prepared under R.I. 
Gen. Laws § 42-35-2.9, including any citations to scientific 
or statistical studies, reports, and analyses that served as a 
basis for the proposed rule: 
 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 

e. If Emergency was chosen: 
 

i. Enter the Brief Statement of Reason for Finding Imminent 
Peril to state the reason this rule is required in order to 
avoid a threat to public health, safety, or welfare, or the 
loss of federal funding for an agency program (R.I. Gen. 
Laws § 42-35-2.10): 
 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 

f. If Advance Notice was chosen: 
 

i. Enter the Advance Notice Details to indicate where, when, 
and how persons may comment before the rulemaking 
process begins (any meeting held is open to the Open 
Meetings Act and subject to R.I. Gen. Laws Chapter 42-46): 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
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(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 

5. Confirm the Additional Information URL is correct to indicate the 
location on your website where the Notice of Proposed Rulemaking is 
published as required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

6. Review to ensure all entered text is correct and click Submit. 
 

DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 
RULEMAKING.  
 

Instead, click the RICR logo at the top-left corner to go back if need be. 
 
 

 
  COMPLETED: Public Comment Period Begin 

 
 

6.3.1.2.4.5 Initial Data Entry and Documents Upload 

 

1. Based on the Rulemaking Action and Process chosen, continue 
rulemaking by following: 
 

a. Proposed Regular Rulemaking in § 6.3.1.2.1.1(9) of this Guide; 
 

b. Proposed Direct Final Rulemaking in § 6.3.1.2.2.1(9) of this 
Guide; 
 

c. Emergency Rulemaking in § 6.3.1.2.3.1(9) of this Guide; or 
 

d. Restart Advance Notice Rulemaking in § 6.3.1.2.4.1(7) of this 
Guide. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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6.3.1.2.5 APA Exempted Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.5 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Approval for Notice of Proposed Rulemaking Rules Coordinator 

DOS Verification of Drafts Department of State 

Submission for Promulgation RICR Filing System 

Rules Coordinator Approval for Final Submission Rules Coordinator 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 

Before initiating the process in the RICR Filing System, email the Administrative 
Records Office (ARO) to request the APA Exemption be applied to the Part to 
be promulgated: 
 

1. Provide the full RICR Citation (##-RICR-##-##-#); and 
 

2. Confirm the promulgating agency/division may use the exemption per 
R.I. Gen. Laws § 42-35-18. 

 
Only once the ARO confirms in an email reply that the exemption was applied 
can the process be started in the RICR Filing System. 
 
 

6.3.1.2.5.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, and: 
 

a. Ensure the New Adoption button is green, not blue; and 
 

If the button is blue, do not move forward with the promulgation 
and immediately contact the ARO per § 6.3.1.2.5 of this Guide. 
 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
https://rules.sos.ri.gov/
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b. Click the Download Document icon to draft the amendment (see 
§ 5.1.2.2 of this Guide for additional information): 

 

 
 

3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Amendment icon promulgate an amendment: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
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a. The Rulemaking Action should immediately display APA 
Exempted: 
 

 
 

If the Rulemaking Action does not display APA Exempted, do not 
move forward with the promulgation and instead scroll to the 
bottom of the page to click Cancel and email the ARO 
immediately to fix this; 
 

b. Confirm the Regulation Title uses sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 

mailto:rulesregs@sos.ri.gov
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6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 
 
 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

  
 

10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule (actually the Final Rule, 2 versions)* 
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ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

* There will be no option to upload a “Final Rule”. 
Upload the Final Rule as the Proposed Rule document type. 

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
 

11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
 

12. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
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Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

13. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

14. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 16(b)(i): 
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15. To continue, click the Advance Workflow icon: 
 

 
 

16. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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17. Enter what the Effective Date should be set to (i.e., either a minimum 20-
day waiting period or other date) in the Request Note and click Submit: 
 

 
 

18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 
 
 
 
 
 
 
 
 
 



 
 
 
 

 333 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6.3.1.2.5.2 Rules Coordinator Approval for Notice of 
Proposed Rulemaking 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined the filing details needs 

updating or additional documents need to be uploaded, click on the 
Edit Filing icon (paper with pencil) or the Upload Documents icon 
(paper with blue arrow): 
 

 
 

2. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 4(b)(i): 
 

 
 

3. To continue, click the Advance Workflow icon: 
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4. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 
 
 
 
 
 
 
 
 



 
 
 
 

 335 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

5. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

6. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Rules Coordinator Approval for Notice of Proposed 
Rulemaking 
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6.3.1.2.5.3 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.2.5.4 Rules Coordinator Approval for Final 
Submission 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance once the Administrative Records Office has completed their 
formatting review. 
 
1. To advance the rule for final signatures or to terminate the rule, click the 

Advance Workflow icon: 
 

 
 

2. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

3. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Approval for Final Submission 

 
 

6.3.1.2.5.5 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
Once the Rules Coordinator advances the rule, the Agency Head will 
receive an automated email from OneSpan, the esignature provider, to sign 
the rule. 
 
 

6.3.1.2.5.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
 
 

6.3.1.2.5.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
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Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.3 Repeals 

6.3.1.3.1 Proposed Regular Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.1 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.3.1.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
repeal (see § 5.1.2.3 of this guide for additional information): 
 

 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Repeal icon promulgate a repeal: 
 

 
 

4. Confirm the Rulemaking Filing Details: 
 

 
 

a. Confirm Proposed, then Regular, for the Rulemaking Action and 
Rulemaking Process; and 
 

 
 

b. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
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i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 15(b)(i): 
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14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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16. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 14 to proceed. 

 
17. If you would like to add a note for the DOS, enter text in the Request 

Note and/or click Submit: 
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18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 

 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.3.1.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.3.1.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 
 

 

https://rules.sos.ri.gov/
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4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
 

 
 

5. Fill out the form to add a Public Comment Period – all fields are 
required: 
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a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 

 
6. If there will be a hearing, click on the Public Comment Period, then click 

Add >> under Add a Public Hearing: 
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7. Fill out the form to add a Public Hearing – all fields are required: 
 

 
 

8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
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9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
 

10. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 
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  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/organizations
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6. Locate the correct Proposed Rule and click the rule name to view: 
 

 
 

7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
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8. The Overview tab displays the rule details: 
 

 
 
 

6.3.1.3.1.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.3.1.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
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6.3.1.3.1.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
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c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
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4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 

 
ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
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c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
 

6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
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8. To continue, click the Advance Workflow icon: 
 

 
 

9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

10. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 8 to proceed. 

 
11. If you would like to add a note for the DOS (i.e., if you would like the rule 

to become effective on a future date other than the minimum 20-day 
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waiting period), enter text in the Request Note and/or click Submit: 
 

 
 

12. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 
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6.3.1.3.1.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
indicate the rule is ready to be signed by the Agency Head: 
 

 
 
 

6.3.1.3.1.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.3.1.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
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Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
 
 

6.3.1.3.1.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.3.2 Proposed Direct Final Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.2 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

DOS Verification of Drafts Department of State 

Generation of the Notice of Proposed Rulemaking Rules Coordinator 

Submission for Promulgation RICR Filing System 

Public Comment Period Begin RICR Filing System 

Post Public Comment Period Data update and Document 
Upload 

Rules Coordinator 

DOS Final Regulation Approval Department of State 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 
 

6.3.1.3.2.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
repeal (see § 5.1.2.3 of this guide for additional information): 
 

 
 
 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Repeal icon promulgate a repeal: 
 

 
 

4. Confirm the Rulemaking Filing Details: 
 

 
 

a. Confirm Proposed, then Direct Final, for the Rulemaking Action 
and Rulemaking Process; and 
 

 
 

b. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
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i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
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7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

13. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 15(b)(i): 
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14. To continue, click the Advance Workflow icon: 
 

 
 

15. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

16. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 14 to proceed. 
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17. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.3.2.2 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
 

 
 
 

6.3.1.3.2.3 Generation of the Notice Of Proposed 
Rulemaking 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
 
 

https://rules.sos.ri.gov/
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Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Generate/Review Docs icon: 
 

 
 

4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
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5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 
 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 
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6. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 

7. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
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8. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 

 

 
 
 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 
 

https://rules.sos.ri.gov/organizations
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4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
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7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
 

 
 

8. The Overview tab displays the rule details: 
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6.3.1.3.2.4 Submission for Promulgation and Public 
Comment Period Begin 

These steps will be completed automatically by the RICR System. 
 
Once the Public Comment Period ends, the RICR System will automatically 
advance the rule to the next step. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.3.2.5 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
 
 

6.3.1.3.2.5 Post Public Comment Period Data update 
and Document Upload 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 
 

i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 
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b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
 

 
 

c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents in step 4: 
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e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level, then click the Upload Documents icon: 
 

 
 

4. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Concise Explanatory Statement • Public Comment (may 

upload multiple, if necessary) 
• Final Rule (2 versions) 
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ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • State Register publication 

• Petition • Studies/Reports 

• Public Hearing Documents  

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                           
 

b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

5. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 4-5 for each additional document (you will 
not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
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6. Click each tab on the right to ensure rule information and all rulemaking 
documents are correct (Text, Documents, Approvals, and Details): 
 

 
 

7. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 9(b)(i): 
 

 
 
 

8. To continue, click the Advance Workflow icon: 
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9. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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10. If you would like to add a note for the DOS (i.e., if you would like the rule 
to become effective on a future date rather than the last day of the 
Public Comment Period), enter text in the Request Note and/or click 
Submit: 
 

 
 

11. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Post Public Comment Period Data update and 
Document Upload 
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6.3.1.3.2.6 DOS Final Regulation Approval 

This step will be completed by the Administrative Records Office. 
 
Once the DOS formatting review has been completed, the Rules 
Coordinator and Agency Head will receive an AWS Notification email to 
indicate the rule is ready to be signed by the Agency Head: 
 

 
 
 

6.3.1.3.2.7 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.3.2.8 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
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rule and set the rule’s Effective Date. 
 
 

6.3.1.3.2.9 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.3.3 Emergency Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.3 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Notification of Emergency Rule Rules Coordinator 

Submission for Promulgation RICR Filing System 

Agency Head Signature Applied Agency Head 

Governor Signature Applied Governor 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

Submission for Emergency Extension 1 Rules Coordinator 

DOS Final Revision for Emergency Extension 1 Department of State 

Finalization of Emergency Extension 1 RICR Filing System 

 
 

6.3.1.3.3.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
repeal (see § 5.1.2.3 of this guide for additional information): 
 

 
 
 
 
 

https://rules.sos.ri.gov/
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3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Repeal icon promulgate a repeal: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Emergency for the Rulemaking Action; and 
 

 
 

b. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
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i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Enter the Brief Statement of Reason for Finding Imminent Peril to state 
the reason this rule is required in order to avoid a threat to public 
health, safety, or welfare, or the loss of federal funding for an agency 
program (R.I. Gen. Laws § 42-35-2.10): 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 
 

a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

 
 
 
 
 
 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule 
 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
 

                          

 
b. Click Choose File to select the document from your computer; 

and 
 

c. Click Upload Document to upload. 
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11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

12. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Brief Statement of Reason for Finding Imminent 
Peril, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
 

 
 

13. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
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14. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 16(b)(i): 
 

 
 

15. To continue, click the Advance Workflow icon: 
 

 
 

16. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

17. Certify that your agency has either received official approval from OMB 
or is exempt from OMB’s review process by clicking Yes: 
 

 
 

a. If your agency has not received official approval from OMB and 
is not exempt, click the DOS logo in the top-left corner to return 
to the home page. Do not proceed in the RICR System until you 
have official approval. Once your agency receives approval, go 
back to step 15 to proceed. 
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18. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

19. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.3.3.2 Rules Coordinator Notification of 
Emergency Rule 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined that the rule should not 

move forward, click the Terminate icon to end the promulgation process 
and skip to step 3(b)(i): 
 

 
 

2. To continue, click the Advance Workflow icon: 
 

 
 

3. To advance the rule for the DOS Formatting Review, click Advance: 
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a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 
i. Select a Termination Reason, then click Submit to terminate, 

or click Cancel to continue the promulgation process: 
 

 
 

4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Notification of Emergency Rule 

 
 

6.3.1.3.3.3 Submission for Promulgation 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically advance the rule to the next step. 
 
 

6.3.1.3.3.4 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
The Agency Head will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
 
 

6.3.1.3.3.5 Governor Signature Applied 

This step will be completed by the Agency Head. 
 
The Governor will receive an automated email from OneSpan, the 
esignature provider, to sign the rule. 
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6.3.1.3.3.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head and Governor signs the rule, the Department of 
State will sign the rule and set the rule’s Effective Date. 
 
 

6.3.1.3.3.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 
 
 

6.3.1.3.3.8 Submission for Emergency Extension 1 

 

If the Emergency Rule must be extended: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the 60-Day Emergency Renewal icon 
(calendar) next to the Part to be extended: 
 

 
 
 
 
 

https://rules.sos.ri.gov/
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3. To confirm the Part should be extended, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the Emergency Rule immediately, which 
will change the rule’s Expiration Date to be set as today’s date: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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4. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

5. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.3.3.9 DOS Final Revision for Emergency 
Extension 1 

This step will be completed by the Administrative Records Office. 
 
The Department of State will confirm the extension and advance the rule. 
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6.3.1.3.3.10 Finalization of Emergency Extension 1 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically extend the Expiration Date for the 
Emergency Regulation in the RICR. 
 
 

6.3.1.3.3.11 Early Termination 

 

If the Emergency Rule must be terminated before the set Expiration Date: 
 
1. Log in to the RICR: https://rules.sos.ri.gov/. 

 
2. Under Active Emergency Rules, click the Title, Chapter, and Subchapter 

to open each level, and click the Terminate icon next to the Part to be 
terminated: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
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3. Select a Termination Reason, then click Submit to terminate, or click 
Cancel: 

 

 
 

4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

6.3.1.3.3.11.1 Finalization of Termination 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically change the Expiration Date for the 
Emergency Regulation in the RICR to today’s date. 

 
It is the Rules Coordinator’s responsibility to download the signed 
Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.3.4 Advance Notice of Proposed Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.4 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Filer 

Generation of the Notice of Proposed Rulemaking Filer 

Public Comment Period Begin RICR Filing System & Filer 

 
 

6.3.1.3.4.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, then click the Download Document icon to draft the 
repeal (see § 5.1.2.3 of this guide for additional information): 
 

 
 

3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Repeal icon promulgate a repeal: 
 

 
 

https://rules.sos.ri.gov/
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4. Enter and confirm the Rulemaking Filing Details: 
 

 
 

a. Choose Advance Notice for the Rulemaking Action and 
Rulemaking Process; 
 

 
 

b. Confirm the Regulation Title uses sentence case (i.e., use 
“Conduct of Public Hearings”, not “CONDUCT OF PUBLIC 
HEARINGS”); and 
 

c. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
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5. Enter the Advance Notice Details to indicate where, when, and how 
persons may comment before the rulemaking process begins (any 
meeting held is open to the Open Meetings Act and subject to R.I. Gen. 
Laws Chapter 42-46): 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

6. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

7. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

8. DO NOT CLICK ANYTHING UNTIL ALL OPTIONS ARE REVIEWED 
There are three (3) options to move forward based on if documents 
need to be uploaded or not, and two (2) options have immediate 
ramifications.  
 
Advance Notice Rulemaking does not require documents to be 
uploaded, however, if the promulgating agency wants or needs to 
upload documents, the following optional documents may be 
uploaded: 
 

https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule must 
also be uploaded to be able to advance to the next step. 
 
Read through all three options carefully before determining and taking 
action to advance to the next step: 
 

a. Advance Workflow – Choose if you don’t need to upload 
documents. 
If you choose this option, documents may still be uploaded later if need 
be. 
 

See step 9 for next steps. 
 

b. Upload Documents – Choose if you need to upload documents. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

See step 10 for next steps. 
 

c. Home – Equivalent to choosing Upload Documents, do not use. 
If you choose this option and documents do not actually need to be 
uploaded, the RICR System will not allow you to advance the workflow 
until a Proposed Rule is uploaded, so you will need to terminate the rule 
and start over if you do not wish to upload a Proposed Rule. 
 

If accidentally clicked, see step 11 for next steps. 
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9. For Advance Workflow: 
 

a. Click Advance Workflow: 
 

 
 

b. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

  
 

i. If for any reason at this stage it is determined that 
documents need to be uploaded, click Cancel and skip to 
step 11(b); or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
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10. For Upload Documents: 
 

a. Click Upload Documents: 

 

 
 

b. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

c. Click Choose File to select the document from your computer. 
 

d. Click Upload Document to upload. 
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e. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps b-e for each additional document 
(you will not be able to advance the rule until the Proposed Rule is 
uploaded), or click Home: 

 

 
 

f. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 10(h)(ii)(1): 
 

  
 

g. To continue, click the Advance Workflow icon: 
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h. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
 

 
 

11. DO NOT USE – ONLY FOLLOW IF ACCIDENTALLY CHOSEN 
 

For Home: 
 

a. Click Home: 
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b. Click the Upload Documents icon next to the Part in the Work 
Queue tab to upload documents to be able to advance the rule: 
 

 
 

c. Select from the dropdown the Document Type: 

 

 
 

• Proposed Rule • Petition* 

• Index of Studies/Reports* • Additional Documentation* 

• Internal Organization Document* • Studies/Reports* 
 

*This document type cannot be uploaded alone. A Proposed Rule 
must also be uploaded to be able to advance to the next step. 
 

d. Click Choose File to select the document from your computer. 
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e. Click Upload Document to upload. 
 

f. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps c-f for each additional document 
(you will not be able to advance the rule until the Proposed Rule is 
uploaded), or click Home: 

 

 
 

g. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process and skip to step 11(i)(ii)(1): 
 

 
 

h. To continue, click the Advance Workflow icon: 
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i. To advance the rule to generate the Advance Notice of Proposed 
Rulemaking, click Advance and skip to step 12: 
 

 
 

i. If for any reason at this stage it is determined that the rule 
should not move forward, click Cancel to go back; or 
 

ii. Click Terminate to end the promulgation process: 
 

(1) Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the 
promulgation process: 
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12. Certify that your agency will receive official approval from OMB if the 
rule is to be fully promulgated or is exempt from OMB’s review process 
by clicking Yes: 
 

 
 

13. If you would like to add a note for the DOS for the future DOS review, 
enter text in the Request Note and/or click Submit: 
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14. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 

 
 

6.3.1.3.4.2 Generation of the Notice of Proposed 
Rulemaking 

1. In the Work Queue tab, click on the Title, Chapter, and Subchapter to 
open each level to view the rule. 

 

2. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, and 
Advance Notice Details, then click Submit once the details are updated:  
 

Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 

 

 
 

a. Once completed, click the Department of State logo to navigate 
back to the homepage: 
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3. Click the Generate/Review Docs icon: 
 

 
 

4. Click Add >> under Public Comment Period List, and click Edit and  
<< Remove as necessary to adjust the Public Comment Period: 
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5. Fill out the form to add a Public Comment Period – all fields are 
required: 
 

 
 

a. The Date of End of Comment Period will automatically show the 
minimum first eligible date to be chosen, but you may choose a 
future date if needed. 
 

b. Agencies may use the RICR Filing System to accept public 
comments by selecting Yes to Allow online public comments?. 
Agencies may opt out by selecting No. 
 

i. If Yes is selected, you have the option to specify dates for 
when your agency wants to allow online public comments 
within the Public Comment Period. 
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6. If there will be a hearing, click on the Public Comment Period, then click 
Add >> under Add a Public Hearing: 
 

 
 

7. Fill out the form to add a Public Hearing – all fields are required: 
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8. Click Generate Notice (this will not publish the rule, only preview the 
notice): 
 

 
 

9. Review the Notice of Proposed Rulemaking: 
 

 
 

a. If any information within the notice is incorrect, click Cancel to go 
back and edit to update the information and complete steps as 
necessary. 
 

b. Once information is confirmed to be correct, click Publish to 
approve the notice and publish the rule in the RICR. 
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10. Click Home to return to the RICR home page: 
 

a. If after the notice is published there needs to be any changes 
made, click Amend Public Notice to create and publish an 
additional notice with corrections. 

 

  
 
 

 
  COMPLETED: Generation of the Notice Of Proposed Rulemaking 

 
At this time, the Proposed Rule is now live in the RICR and may be viewed 
by completing the following: 
 
1. Go to https://rules.sos.ri.gov/organizations. 

 
2. Locate the associated Title within the Table of Contents. 

 
3. Click the plus sign (+) next to the Title: 

 

 

https://rules.sos.ri.gov/organizations
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4. Click Agency Info: 
 

 
 

5. Click Rulemaking Agenda: 
 

 
 

6. Locate the correct Proposed Rule and click the rule name to view: 
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7. Click through the navigation tabs to view the Overview, Regulation, 
History, Rulemaking Documents, and Comments: 
 

 
 

8. The Overview tab displays the rule details: 
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6.3.1.3.4.3 Public Comment Period Begin 

The first half of this step will be completed automatically by the RICR 
System to start the Public Comment Period in the RICR. 
 
If online public comments were allowed, you may review comments as they 
are submitted, or at the end of the Public Comment Period. See step 2 in the 
following section (§ 6.3.1.3.4.3 of this Guide) for how to review comments 
and generate a public comment document compiling all submitted rules. 
 
 

6.3.1.3.4.4 Public Comment Period Begin 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. If online public comments were allowed, click the Review Comments 
icon, otherwise skip to step 3: 
 

 
 

a. Review every rule listed under the Pending tab by clicking Review 
for each comment submitted: 
 

 

https://rules.sos.ri.gov/
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i. Select to display the comment in the RICR or not, add any 
internal and public notes, and click OK to approve: 

 

 
 

b. Click the Reviewed tab to view who reviewed the comment, when 
it was approved, and review again if necessary: 
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c. Click Print to generate a public comment document: 
 

 
 

d. Click the down arrow at the top-right of the PDF viewer to 
download the document so that it can be used to upload as the 
part of the final rulemaking documents: 
 

 
 

e. To navigate back to the homepage, click the Department of State 
logo: 
 

 
 

3. To start rulemaking, in the Work Queue tab, click on the Title, Chapter, 
and Subchapter to open each level, then click the Start Rulemaking 
icon: 
 

 
 



 
 
 
 

 435 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click the Terminate icon to end the 
promulgation process: 
 

 
 

b. Select a Termination Reason, then click Submit to terminate. 
 
DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 
RULEMAKING.  
 
Instead, click the RICR logo at the top-left corner to go back if 
need be. 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
 

a. Choose the Rulemaking Action and Rulemaking Process to start 
rulemaking, either Proposed Regular, Proposed Direct Final, or 
Emergency: 
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If another Advance Notice Public Comment Period is necessary, 
choose Advance Notice. 
 

 
 

b. Confirm the Regulation Title is correct and uses sentence case 
(i.e., use “Conduct of Public Hearings”, not “CONDUCT OF 
PUBLIC HEARINGS”); and 
 

c. Confirm the Rulemaking Authority is correct and update as 
necessary by selecting the appropriate authority from the 
dropdown, enter the Rulemaking Authority citation, and click 
Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 

 

 
 

d. If Proposed Regular or Proposed Direct Final was chosen: 
 

i. Enter the Summary of Proposed Rule in plain language of 
terms or substance of intended action, or description of 
the subjects and issues involved, including changes 
between current and proposed regulations: 

 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 
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ii. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal 
cost and benefits of compliance as prepared under R.I. 
Gen. Laws § 42-35-2.9, including any citations to scientific 
or statistical studies, reports, and analyses that served as a 
basis for the proposed rule: 
 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 
e. If Emergency was chosen: 

 
i. Enter the Brief Statement of Reason for Finding Imminent 

Peril to state the reason this rule is required in order to 
avoid a threat to public health, safety, or welfare, or the 
loss of federal funding for an agency program (R.I. Gen. 
Laws § 42-35-2.10): 
 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 

f. If Advance Notice was chosen: 
 

i. Enter the Advance Notice Details to indicate where, when, 
and how persons may comment before the rulemaking 
process begins (any meeting held is open to the Open 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.10.htm
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Meetings Act and subject to R.I. Gen. Laws Chapter 42-46): 
 

(1) If copying text from another document, follow 
the directions on screen to strip all erroneous 
formatting. 

 

 
 

5. Confirm the Additional Information URL is correct to indicate the 
location on your website where the Notice of Proposed Rulemaking is 
published as required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

6. Review to ensure all entered text is correct and click Submit. 
 
DO NOT CLICK Cancel – THIS WILL START PROPOSED REGULAR 
RULEMAKING.  

 
Instead, click the RICR logo at the top-left corner to go back if need be. 
 
 

 
  COMPLETED: Public Comment Period Begin 

 
 

6.3.1.3.4.5 Initial Data Entry and Documents Upload 

 

1. Based on the Rulemaking Action and Process chosen, continue 
rulemaking by following: 
 

a. Proposed Regular Rulemaking in § 6.3.1.3.1.1(9) of this Guide; 
 

b. Proposed Direct Final Rulemaking in § 6.3.1.3.2.1(9) of this 

https://webserver.rilegislature.gov/Statutes/TITLE42/42-46/INDEX.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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Guide; 
 

c. Emergency Rulemaking in § 6.3.1.3.3.1(9) of this Guide; or 
 

d. Restart Advance Notice Rulemaking in § 6.3.1.3.4.1(7) of this 
Guide. 
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6.3.1.3.5 APA Exempted Rulemaking 

For information regarding this Rulemaking Action, see § 3.3.5 of this Guide. 
 

Actions to be Completed User to Complete 

Initial Data Entry and Documents Upload Rules Coordinator 

Rules Coordinator Approval for Notice of Proposed Rulemaking Rules Coordinator 

DOS Verification of Drafts Department of State 

Submission for Promulgation RICR Filing System 

Rules Coordinator Approval for Final Submission Rules Coordinator 

Agency Head Signature Applied Agency Head 

Final Rule and Signature Acceptance by DOS Department of State 

Promulgation Finalization RICR Filing System 

 

Before initiating the process in the RICR Filing System, email the Administrative 
Records Office (ARO) to request the APA Exemption be applied to the Part to 
be promulgated: 
 

1. Provide the full RICR Citation (##-RICR-##-##-#); and 
 

2. Confirm the promulgating agency/division may use the exemption per 
R.I. Gen. Laws § 42-35-18. 

 

Only once the ARO confirms in an email reply that the exemption was applied 
can the process be started in the RICR Filing System. 
 
 

6.3.1.3.5.1 Initial Data Entry and Documents Upload 

 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the Current Rules tab, click the Title, Chapter, Subchapter, and Part to 
open each level, and: 
 

a. Ensure the New Adoption button is green, not blue; and 
 

If the button is blue, do not move forward with the promulgation 
and immediately contact the ARO per § 6.3.1.3.5 of this Guide. 
 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-18.htm
https://rules.sos.ri.gov/
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b. Click the Download Document icon to draft the repeal (see § 
5.1.2.3 of this guide for additional information): 

 

 
 

3. Once the Proposed Rule draft is ready, in the Current Rules tab, click the 
Title, Chapter, Subchapter, and Part to open each level, then click the 
New Repeal icon promulgate a repeal: 
 

 
 

4. Enter and confirm the Rulemaking Filing Details: 
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a. The Rulemaking Action should immediately display APA 
Exempted: 
 

 
 
If the Rulemaking Action does not display APA Exempted, do not 
move forward with the promulgation and instead scroll to the 
bottom of the page to click Cancel and email the ARO 
immediately to fix this; and 
 

b. Confirm the appropriate authority from the dropdown, enter the 
Rulemaking Authority citation, and click Add. 
 

i. To remove a Rulemaking Authority, click to select the 
citation to remove from the list and click Remove: 
 

 
 

5. Enter the Summary of Proposed Rule in plain language of terms or 
substance of intended action, or description of the subjects and issues 
involved, including changes between current and proposed regulations: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 
 
 

mailto:rulesregs@sos.ri.gov
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6. Enter the Regulatory Analysis Summary and Supporting 
Documentation to provide a brief paragraph of the societal cost and 
benefits of compliance as prepared under R.I. Gen. Laws § 42-35-2.9, 
including any citations to scientific or statistical studies, reports, and 
analyses that served as a basis for the proposed rule: 
 

a. If copying text from another document, follow the directions on 
screen to strip all erroneous formatting. 

 

 
 

7. Confirm the Additional Information URL to indicate the location on your 
website where the Notice of Proposed Rulemaking is published as 
required by R.I. Gen. Laws § 42-35-2.7: 
 

 
 

8. Review to ensure all entered text is correct and click Submit. 
 

a. At any point during the above process, if you don’t wish to move 
forward, click Cancel to prevent the Part number from being 
used. 
 

9. This Rulemaking Action requires documents to be uploaded. Click 
Upload Documents: 
 

 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.9.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-2.7.htm
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a. If you click Home by accident, click the Upload Documents icon 
next to the Part in the Work Queue tab to go to the correct 
screen: 
 

  
 

10. Upload documents: 
 

 
 

a. Select from the dropdown the Document Type: 
 

i. Required: 

• Proposed Rule (actually the Final Rule, 2 versions)* 

 

ii. Optional: 

• Index of Studies/Reports • Additional Documentation 

• Internal Organization Document • Studies/Reports 

• Petition  
 

* There will be no option to upload a “Final Rule”. 
Upload the Final Rule as the Proposed Rule document type. 

 
A list of required documents will display, and as documents are 
uploaded, a green check will be added next to each document: 
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b. Click Choose File to select the document from your computer; 
and 
 

c. Click Upload Document to upload. 
 

11. If additional documents need to be uploaded, click Upload More 
Documents and repeat steps 10-11 for each additional document (you 
will not be able to advance the rule until all required documents are 
uploaded), or click Home to continue to the next step: 
 

 
 

a. When uploading the Final Rule, upload the Track Changes 
Version first, then upload the Clean Version with all changes 
accepted (§ 5.1.2.4 of this Guide). 
 

12. If for any reason the rule details need to be updated, click the Edit Filing 
icon to update the Regulation Title, Rulemaking Authority, Summary of 
Proposed Rule, and Regulatory Analysis Summary and Supporting 
Documentation, then click Submit once the details are updated:  
 
Once the Notice of Proposed Rulemaking is generated and published, 
this information cannot be changed. 
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13. Click each tab on the right to ensure all information regarding the rule is 
correct (Text, Documents, Approvals, and Details): 
 

 
 

14. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 16(b)(i): 
 

 
 

15. To continue, click the Advance Workflow icon: 
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16. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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17. Enter what the Effective Date should be set to (i.e., either a minimum 20-
day waiting period or other date) in the Request Note and click Submit: 
 

 
 

18. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Initial Data Entry and Documents Upload 
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6.3.1.3.5.2 Rules Coordinator Approval for Notice of 
Proposed Rulemaking 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance if a Filer completed the Initial Data Entry and Documents Upload. 
 
1. If for any reason at this stage it is determined the filing details needs 

updating or additional documents need to be uploaded, click on the 
Edit Filing icon (paper with pencil) or the Upload Documents icon 
(paper with blue arrow): 
 

 
 

2. If for any reason at this stage it is determined that the rule should not 
move forward, click the Terminate icon to end the promulgation process 
and skip to step 4(b)(i): 
 

 
 

3. To continue, click the Advance Workflow icon: 
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4. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
 

i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 
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5. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
 

 
 

6. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: 

Rules Coordinator Approval for Notice of Proposed 
Rulemaking 
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6.3.1.3.5.3 DOS Verification of Drafts 

This step will be completed by the Administrative Records Office. 

Once the DOS formatting review has been completed, the Rules 
Coordinator will receive an AWS Notification email to indicate the next step 
should be taken: 
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6.3.1.3.5.4 Rules Coordinator Approval for Final 
Submission 

The Rules Coordinator will receive an AWS Notification when it is time to 
advance once the Administrative Records Office has completed their 
formatting review. 
 
1. To advance the rule for final signatures or to terminate the rule, click the 

Advance Workflow icon: 
 

 
 

2. To advance the rule for the DOS Formatting Review, click Advance: 
 

 
 

a. If for any reason at this stage it is determined that the rule should 
not move forward, click Cancel to go back; or 
 

b. Click Terminate to end the promulgation process: 
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i. Select a Termination Reason, then click Submit to 
terminate, or click Cancel to continue the promulgation 
process: 

 

 
 

3. If you would like to add a note for the DOS, enter text in the Request 
Note and/or click Submit: 
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4. Upon submitting, click OK to return to the RICR System homepage: 
 

 
 
 

 
COMPLETED: Rules Coordinator Approval for Final Submission 

 
 

6.3.1.3.5.5 Agency Head Signature Applied 

This step will be completed by the Agency Head. 
 
Once the Rules Coordinator advances the rule, the Agency Head will 
receive an automated email from OneSpan, the esignature provider, to sign 
the rule. 
 
 

6.3.1.3.5.6 Final Rule and Signature Acceptance by 
DOS 

This step will be completed by the Administrative Records Office. 
 
Once the Agency Head signs the rule, the Department of State will sign the 
rule and set the rule’s Effective Date. 
 
 

6.3.1.3.5.7 Promulgation Finalization 

This step will be completed automatically by the RICR System. 
 
The RICR System will automatically display the Final Regulation in the RICR 
the day it becomes effective. 

 
It is the Rules Coordinator’s responsibility to download the signed 
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Regulation for the agency’s files to be permanently retained per GRS2.5 
Rulemaking Files. 
 

Final Regulations can be downloaded by opening the active Part in the 
RICR, clicking the Regulation tab, and clicking Download Regulation: 
 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://sosri.access.preservica.com/index.php?name=SO_acb4d5f5-cedb-4767-8e15-634e8a9f7ce3
https://rules.sos.ri.gov/Organizations
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6.3.1.4 Periodic Refiles 

For information regarding this Rulemaking Type, see § 3.3.7 of this Guide. 
 
The Administrative Records Office (ARO) will alert Rules Coordinators once rules 
for Periodic Refile are ready to confirm in the RICR Filing System. Only then will 
Rules Coordinators be able to access the Period Refile page after logging in. 
 
If for any reason the Period Refile page is not visible after logging in, email the 
ARO for next steps. 
 
To complete the Periodic Refile process for each active Part: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Periodic Refile: 
 

 
 

3. Click the yellow icon next to the Part to refile: 
 

 

mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
https://rules.sos.ri.gov/
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4. Upon success, the following message will display: 
 

 
 

5. Repeat steps 2 through 4 until all Parts to be refiled have been refiled. 
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6.3.1.5 Technical Revisions 

For information regarding this Rulemaking Type, see § 3.3.6 of this Guide. 
 

Minor non-substantive changes in spelling, grammar, and/or format in the Final 
Rule can be made through a written email request from an agency’s Rules 
Coordinator or initiated by the Administrative Records Office (ARO) (R.I. Gen. 
Laws § 42-35-4(b)).  
 

If a Technical Revision is initiated by the ARO to correct formatting, the Rules 
Coordinator will be notified of the change. 
 

To request a Technical Revision for a currently active Final Regulation: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Within the Current Rules tab, click the Title, Chapter, Subchapter, and Part: 
 

 
 

3. Click the Download Document icon (piece of paper with blue arrow): 
 

 
 

4. Edit the document with the proposed minor non-substantive change(s) 
using Track Changes (§ 5.1.2.2 of this Guide). 
 

5. Email the updated Rule and include the changed section number(s) within 
the email body to rulesregs@sos.ri.gov for review. 
 

6. Upon review, the ARO will either: 
 

a. Complete the Technical Revision, if approved; or 
 

b. Provide a recommendation for how the change(s) can be made using 
other rulemaking processes, if not approved as a Technical Revision. 

http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
http://webserver.rilin.state.ri.us/Statutes/TITLE42/42-35/42-35-4.htm
https://rules.sos.ri.gov/
mailto:rulesregs@sos.ri.gov


 
 
 
 

 460 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6.3.2 Filing FAQ 

Where can the most recent version of a rule be downloaded? 

See §§ 5.1.2.2 (Amendments) and 5.1.2.3 (Repeals) of this Guide for instructions to 
download the most recent version of a rule to draft an amendment or repeal. 

What’s the difference between the three rule tabs in the RICR Filing System? 

• Current Rules displays all rules that are currently in effect and active in the 
RICR. 
 

• Work Queue displays all rules that need agency action for the current step in 
the promulgation process. 
 

• Under Review displays all rules that either need Department of State action for 
the current step in the promulgation process or rules that have been signed 
and are in the waiting period before going into effect. 

How can I find out where in the promulgation process a rule is? 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the rule in either the Work Queue or Under Review tabs. 
 

3. Click on the rule and then click the Approvals tab to the right. 
 

4. Identify which action is bolded. 
 

The bolded action is the step that still needs to be completed. All previous actions 
will list the date the action was completed and the name of the user who completed 
the action. 

Why can’t I see the Advance icon to advance the rule to the next step? 

Check to ensure all required documents have been uploaded by clicking the Upload 
Documents icon (paper with blue arrow), where all required documents are listed. 

What can I do if the wrong file was accidentally uploaded in the RICR Filing System? 

• For Regulation files: 
The previously uploaded files cannot be deleted. Instead, upload the correct 
file. The most recently uploaded file will be the file the RICR uses. 
 

• For any other file: 
Click Delete next to the wrong file, then upload the correct file: 
 

 

https://rules.sos.ri.gov/
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How can a rule be pulled back into an agency’s Work Queue if it was accidentally 
advanced? 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the rule in the Under Review tab. 
 

3. Click Reset to the right of the rule: 
 

 
 

4. Add a note as to why the rule has been reset, and click Submit: 
 

 

https://rules.sos.ri.gov/
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Can the Notice of Proposed Rulemaking document be edited after it has been 
published in the RICR? 

Once the Notice of Proposed Rulemaking has been published, it cannot be edited. 
Always check the generated PDF before publishing to ensure information is correct. 
 

If an agency wishes to publish an additional Notice with updated information: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Locate the rule in the Work Queue tab. 
 

3. Click on the Generate Document icon (paper with magnifying glass). 
 

4. Either Add >> an additional Public Comment Period, or << Remove and Add 
>> an additional Public Comment Period, fill out the form for the Public 
Comment Period information, click Generate, review the generated PDF for 
errors, and click Publish once ready. 

The Agency Head never received the OneSpan email, now what? 

Always check spam and junk folders to ensure security filters did not catch the email. 
 

If the email still cannot be found, email the Administrative Records Office (ARO) with 
the Promulgation ID (§ 6.2.5 of this Guide) and Rule Citation so they can resend the 
OneSpan email. 

Can a rule be pulled back a step once it has been signed? 

Once a rule has been signed, it cannot be reset in any way. If changes to the rule are 
required, an Amendment must be promulgated. 

How can I reset my password? 

Email the ARO to request a password reset and complete the steps listed in § 6.4.1 of 
this Guide. 
 
 
 
 
 
 
 
 
 
 
 
 

https://rules.sos.ri.gov/
mailto:rulesregs@sos.ri.gov
mailto:rulesregs@sos.ri.gov
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6.4 RICR Non-Rulemaking Processes 

6.4.1 Password Reset 

To reset your password for the RICR, email the Administrative Records Office to 
request a password reset and to receive an automated email from the RICR System 
with a temporary password. 
 
To reset the password: 
 

1. Go to the RICR: https://rules.sos.ri.gov/. 
 

2. Log in with the temporary password from the RICR System automated email. 
 

3. Enter the temporary password from the email as the Current Password. 
 

4. Enter a New Password. 
 

5. Enter the new password again to Confirm New Password. 
 

6. Click Change Password: 
 

 
 

NOTE:  Passwords must be more than or equal to 8 characters, and contain at 
least one number, one uppercase, and one special character. 

mailto:rulesregs@sos.ri.gov
https://rules.sos.ri.gov/
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6.4.2 RICR System Notifications 

This Section is for Rules Coordinators and Agency Heads only (§ 6.1.4 of this Guide). 
 
When action is required to be taken by a user in the RICR Filing System, an 
automated notification email from AWS Notifications (no-reply@sns.amazonaws.com) 
is sent. 
 
To turn RICR System notifications on and off for users: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Notifications: 
 

 
 

3. Click the corresponding blue button for a user: 
 

a. Subscribe to turn on RICR Notifications; or 
 

b. Unsubscribe to turn off RICR notifications: 
 

 
 

 
 
 
 
 

mailto:no-reply@sns.amazonaws.com
https://rules.sos.ri.gov/
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6.4.3 Users 

This Section is for Rules Coordinators and Agency Heads only (§ 6.1.4 of this Guide). 
 
 

6.4.3.1 Edit My Account Details 

To edit your user information: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click your name in the upper-right corner: 
 

 
 

4. Edit the fields that require updating and click Save User Details: 
 

 

https://rules.sos.ri.gov/
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6.4.3.2 Add Filer 

To add a Filer: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the header, click Manage > Users: 
 

 
 

3. Click New User in the upper-right corner: 
 

 
 

4. Enter the information for the following fields: 
 

a. Email*; 
 

b. First Name*; 
 

c. Middle Name; 
 

d. Last Name*; 
 

e. Username* (must use email address); 
 

f. Password and Re-enter Password*; 
 

g. Contact Email*; and 
 

h. Contact Phone*. 
 

*Required 
 
 

https://rules.sos.ri.gov/
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5. Click Save User Details: 
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6.4.3.3 Edit User 

To edit a user: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. In the header, click Manage > Users: 
 

 
 

3. Locate the user to edit and click the user’s username. 
 
 

4. Edit the fields that require updating and click Save User Details: 
 

 
 
 

https://rules.sos.ri.gov/
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6.4.4 Guidance Documents 

6.4.4.1 Adding Guidance Documents 

To add a new Guidance Document: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Guidance Document Index: 
 

 
 

3. Click New in the upper-right corner: 
 

 
 
 

https://rules.sos.ri.gov/
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4. Complete the following required fields: 
 

 
 

a. Click to select the Effective Date from the calendar; 
 

b. Enter the Document Title; 
 

c. Paste the URL to the Document On Your Website (include “http://” 
or “https://”); and 

 
d. Click Add. 

 
5. Repeat the previous step as needed to add multiple Guidance Documents. 

 
6. To publish, click Generate Guidance Document Index: 

 

 
 

7. The following message will appear after the index is generated: 
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6.4.4.2 Removing Guidance Documents 

To remove a Guidance Document: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Guidance Document Index: 
 

 
 

3. Click New in the upper-right corner: 
 

 
 

 
 
 

https://rules.sos.ri.gov/
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4. Select a Guidance Document to be removed from the list and click 
Remove: 
 

 
 

NOTE:  The Remove button will not appear until a document is selected. 

 
5. Repeat as needed to remove multiple Guidance Documents. 

 
6. Verify the document(s) are removed from the Guidance Document List and 

click Generate Guidance Document Index to finalize the removal: 
 

 
 

7. The following message will appear after the index is generated: 
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6.4.4.3 Generating the Guidance Document Index 

Each time a Guidance Document is added or removed, a Guidance Document 
Index must be generated to update the RICR. 
 
To generate a Guidance Document Index: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Guidance Document Index: 
 

 
 

3. Click New in the upper-right corner: 
 

 
 

https://rules.sos.ri.gov/
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4. To publish, click Generate Guidance Document Index: 
 

 
 

5. The following message will appear after the index is generated: 
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6.4.4.4 Annual Guidance Document Index 

Agencies must file their Guidance Document Index annually with the Department 
of State and publish it on the agency’s website (R.I. Gen. Laws § 42-35-2.12). If an 
agency does not have any Guidance Documents, the agency is still required to file 
a Guidance Document Index annually by publishing a blank index. 
 
This annual filing does not preclude an agency from updating its Guidance 
Document Index throughout the year as new documents are published. 
 
The Administrative Records Office will send a reminder to Rules Coordinators 
annually in January. Agencies may download a copy to manually post on the 
agency’s website, or agencies may link directly to the RICR Guidance Document 
Index (§ 2.6.1 of this Guide). 
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6.4.5 Declaratory Orders 

6.4.5.1 Rules Coordinator 

6.4.5.1.1 Creating Declaratory Orders 

To add a new Declaratory Order: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Declaratory Orders: 
 

 
 

3. Click New in the upper-right corner: 
 

 
 

4. Enter the Document Title, click Choose File to select a PDF, and click 
Upload Document to upload: 
 

 
 

5. The following message will appear after the Declaratory Order was 
uploaded: 
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6. Under Status, click Approve to advance the Declaratory Order, or click 
Reject to delete the Declaratory Order: 

 

 
 

NOTE:  To set the Effective Date in the future, before approving, 
email the ARO to provide the future date. 

 
7. The following message will appear after the Declaratory Order was 

approved: 
 

 
 

8. The following status will display until the DOS completes their review: 
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9. Once the DOS approves the Declaratory Order and sets the Effective 
Date, log in and generate a Declaratory Index to update the RICR by 
clicking Generate Index: 
 

 
 

NOTE:  Red text means the Declaratory Order is not part of the 
Declaratory Order Index in the RICR yet and a new index 
must be generated to update. 

 
10. The following message will appear after the Declaratory Order Index 

was created: 
 

 
 

11. Confirm the Declaratory Order was included in the index by verifying 
any red text now displays as black text: 
 

 



 
 
 
 

 479 of 487 
 

 

RI Department of State – Administrative Records Office 

AGENCY GUIDE: RULES COORDINATORS 

6.4.5.1.2 Approving/Rejecting Declaratory Orders 

To approve or reject a new Declaratory Order submitted by a Filer: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Declaratory Orders: 
 

 
 

3. Under Status, click Approve to advance the Declaratory Order, or click 
Reject to delete the Declaratory Order: 
 

 
 

NOTE:  If the agency wants the Effective Date to be set in the future, 
email the ARO before approving the Declaratory Order to 
provide a future date. 

 
4. The following message will appear after the Declaratory Order was 

approved: 
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5. The following status will display until the DOS completes their review: 
 

 
 

6. Once the DOS approves the Declaratory Order and sets the effective 
date, log in and generate a Declaratory Index to update the RICR by 
clicking Generate Index: 
 

 
 

NOTE:  Red text means the Declaratory Order is not part of the 
Declaratory Order Index in the RICR yet and a new index 
must be generated to update the RICR. 

 
7. The following message will appear after the Declaratory Order Index 

was created: 
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8. Confirm the Declaratory Order was included in the index by verifying 
any red text now displays as black text: 
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6.4.5.1.3 Generating the Declaratory Order Index 

To generate a new Declaratory Order Index: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Declaratory Orders: 
 

 
 

3. Click Generate Index at the bottom-left corner: 
 

 
 

4. The following message will appear after the Declaratory Order Index 
was created: 
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6.4.5.1.4 Deleting Declaratory Orders 

To delete a new Declaratory Order: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Declaratory Orders: 
 

 
 

3. Check to select the Declaratory Order to delete and click Delete: 
 

 
 

4. Click OK to confirm the Declaratory Order should be deleted: 
 

 
 

5. The following message will appear after the Declaratory Order is 
deleted: 
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6.4.6 Adding New Chapters 

For Rules Coordinators and Agency Heads only (§ 6.1.4 of this Guide). 
 
To create a new Chapter: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Chapters: 
 

 
 

3. In the upper-right corner, click New: 
 

 
 

4. Enter the Chapter Number and Chapter Name and click Create Chapter: 
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a. If the Chapter Number is in use, the system will not let it be used again: 
 

 
 

5. The following message will appear after the Chapter is created: 
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6.4.7 Adding New Subchapters 

For Rules Coordinators and Agency Heads only (§ 6.1.4 of this Guide). 
 
To create a new Subchapter: 
 

1. Log in to the RICR: https://rules.sos.ri.gov/. 
 

2. Click Manage > Subchapters: 
 

 
 

3. In the upper-right corner, click New: 
 

 
 

4. Select the Chapter Number, enter the Subchapter Number, enter the 
Subchapter Name, and click Create Subchapter: 
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a. If the Subchapter Number is in use, the system will not let it be used 
again: 
 

 
 

5. The following message will appear after the Subchapter is created: 
 

 


